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Welcome to Geographic Imager, the newest addition to the Avenza suite of mapping plug-ins for the desktop 
graphics environment.

Combined with Adobe Photoshop, Geographic Imager revolutionizes the way spatial imagery is created, edited 
and maintained by allowing spatial image files to be created, edited and managed in the familiar and widely-used 
Adobe Photoshop environment. Geographic Imager allows the most common spatial imaging tasks to be 
performed where they should be done, in a powerful raster editing environment, and adds the dozens of powerful 
Adobe Photoshop tools and operations to those that one can perform on such imagery.

Geographic Imager is comprised of a series of geospatial tools for Adobe Photoshop that will continually improve 
on each previous version by adding additional file support, tools and improvements to existing tools. Geographic 
Imager is also the perfect companion suite for MAPublisher and Adobe Illustrator users.

This manual assumes that the user is familiar with Adobe Photoshop and has at least a basic understanding of 
geographic information systems (GIS) terminology and concepts. Please refer to your Adobe Photoshop user guide 
for more information on using Adobe Photoshop. Please refer to the document Avenza Projections Guide.pdf for 
more information on the projections supported in Geographic Imager.

By following this manual, learn how to work with spatial imagery using the Geographic Imager functions in Adobe 
Photoshop. This manual covers the concepts necessary to open, edit, transform, mosaic, tile and GeoCrop spatial 
images. A variety of sample imagery has been provided on your Geographic Imager DVD or with your Geographic 
Imager download for use with this guide and the tutorials (see Tutorial Guide). However we do encourage you to 
experiment with your own data to gain additional experience with Geographic Imager tools and functions.

Together Geographic Imager and Adobe Photoshop will give you a totally integrated spatial image software system 
with graphics tools and geographic functions present in the same work environment.

So join first class mapping organizations from around the world and experience modern day imaging by reading 
this user guide,  going through the tutorials and experimenting with Geographic Imager.

Welcome
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Geographic Imager is a powerful suite of tools and functions for Adobe Photoshop that enables spatial imagery to 
be opened, edited, transformed and saved while retaining all the spatial properties of the image. While many spatial 
images are of a format that Adobe Photoshop can natively open and edit, without the presence of Geographic 
Imager all geospatial properties of such images will be lost upon re-saving or exporting the image.

In addition to ensuring a safe and trouble-free editing environment for your geospatial photographs and scans, 
Geographic Imager offers specialized tools for performing certain spatial operations on the image beyond the 
standard image editing functions native to Adobe Photoshop.

The following is a brief outline of the functions and tools included in Geographic Imager.

GeoTransform technology
Avenza uses GeoTransform technology in Geographic Imager for Adobe Photoshop. GeoTransform, which forms the 
basis for the Blue Marble Geographic Transformer product, embeds a sophisticated image reprojection engine into 
Geographic Imager. GeoTransform creates an image map from a source image, georeferencing information, and 
destination image parameters, and performs spatial transformations on geographic imagery. 

Georeference in Adobe Photoshop
Geographic Imager adds a world coordinate grid to the page and pixel grid systems native to Adobe Photoshop. 
It allows for the creation and maintenance of this image-to-world relationship throughout Adobe Photoshop 
operations so that once the image is re-saved or exported the correct georeferencing is preserved. Specifically, 
Geographic Imager provides smart support for most image level operations, such as crop and resize, and tracks the 
changes to the image geometry, updating the reference information accordingly. The image coordinate system and 
ground control point input format can be specified within the Georeference dialog box. The Quick Georeference 
functions has an additional option to load the reference of another file. Also have the ability to remove 
georeferencing. Most of Adobe Photoshop functions are supported. See Chapter 1  for the list of exceptions.

Open/Save spatial imagery
When opening geographic imagery, Geographic Imager automatically recognizes GIS raster formats and attempts 
to locate matching reference files. This information is displayed in the Geographic Imager panel. When saving a 
geographic image using the native Adobe Photoshop File > Save or File > Save As commands, Geographic Imager 
automatically creates a corresponding reference file or GeoTIFF header information. All Adobe Photoshop image 
export formats are supported by Geographic Imager including the native Adobe Photoshop .psd format and the 
Adobe Acrobat .pdf format. All formats other than GeoTIFF will be referenced using an external reference file (e.g. 
a world file). Certain image formats such as MrSID, JPG2000 and DEMs cannot be opened by Adobe Photoshop 
without Geographic Imager installed. Certain formats cannot be saved to their original format and must be saved to 
another format such as GeoTIFF.

Transform
Geographic Imager includes extensive support for thousands of geodetic and projected coordinate systems that 
allow spatial imagery to be projected and transformed in Adobe Photoshop. Support for customized projections as 
well as the ability to save custom definitions for later use is also included. 

Mosaic
Geographic Imager allows Adobe Photoshop to automatically combine multiple geographic images to create 
image mosaics while retaining the georeferencing properties in the new larger image. Create a seamless image 
from individual image files. 

What is Geographic Imager?
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Georeference with GCPs
Geographic Imager allows the referencing of non referenced images, rectification and image correction using 
known ground control points (GCP) by the pixel value, geodetic coordinate, and projected coordinate. Perform 
transformation of images to fit the GCP with minimal errors. Multiple transformation methods are supported 
including affine and polynomial. GCP data can also be saved as a reference file for later use.

Tile
Geographic Imager allows Adobe Photoshop to automatically divide spatial imagery into multiple smaller spatial 
images while retaining the georeferencing properties in each smaller image. Multiple options are available for 
determining how the tiled images will be created. 

Advanced Import
Formerly known as the GeoCrop Import function, the Advanced Import is now available from the Geographic 
Imager panel. Advanced Import crops images before they are opened. This may prevent long loading times with 
large files and improve performance. 

DEM Schema
DEMs provide an effective method of storing information for a continuous surface. DEM data needs to be rendered 
so it can be displayed visually. Depending on what type of DEM data it is and how it should look, the type of 
rendering schema needs to be customized or automatically assigned. Also, support for elevation display and 
mosaicking of DEM images imported with the same schema.

Terrain Shader
The new Terrain Shader tool dynamically applies terrain shading and color maps to digital elevation models within 
Adobe Photoshop. Import a DEM and easily and quickly apply colours and shades based on elevation and even 
apply a specific light source position and intensity to achieve a specific shading effect. Easily generate custom 
colour maps or import existing Adobe Photoshop gradients to use as colour maps.

Automate Tools
All Geographic Imager functions are now fully compatible with scripts and actions. Easily create custom scripts 
and actions to automate repetitive tasks. Geographic Imager JavaScript functions can be fully configured with 
comprehensive parameters.

Licence management
Easily manage license options including commercial, academic, multi-user and floating. Activation maintains 
customer privacy and does not change the terms of the existing Product License Agreement. Please refer to page 16 
for more information on licensing procedures in Geographic Imager. 

Geographic Imager offers a floating license option which enables licenses to be shared across a network by 
multiple users. In such a scenario the Geographic Imager client software can be installed on an unlimited number 
of computers while concurrent use is limited by the number of floating licenses purchased. This multi-platform 
solution offers support for Windows, Mac and Linux servers alike and includes the ability to check-out a license 
for remote use on a laptop computer as well as Internet-enable access for remote users. Floating licenses are a 
wonderful cost-effective way of sharing software amongst multiple users in a network environment. See the RLM 
guide included in the Geographic Imager install folder.
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Adobe Photoshop CS6 compatibility
Geographic Imager 4 is fully compatible with Adobe Photoshop CS6.  A refresh of the Geographic Imager panel 
matches the updated CS6 light and dark user interfaces.

And more
Various bug fixes and user experience enhancements.

What’s new in Geographic Imager 4?
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Before using Geographic Imager please read this section 
thoroughly to ensure that you have a suitable hardware setup, 
become familiar with the installation and licensing procedure, 
and adequately prepare your workspace.

In particular, please pay careful attention to the section 
entitled Compatibility with Adobe Photoshop.

Topics covered in this section:
System Requirements
Installation Instructions
License Management
Geographic Imager Tools
Compatibility with Adobe Photoshop 
Compatibility with MAPublisher and Other Applications

Getting 
Started
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Before installing Geographic Imager, please ensure that these minimum system requirements are met 
(recommended requirements are mentioned as necessary):

Windows

•	 Adobe Photoshop* CS5† (including 64-bit) / CS5.1 (including 64-bit) / CS6 (including 64-bit)

•	 2 GHz or faster Intel Pentium 4 processor (Intel Core 2 Duo or better recommended)

•	 Windows XP,  Windows Vista or Windows 7

•	 4 GB of RAM (8 GB recommended)

•	 300 MB of available hard-disk space

•	 DVD-ROM drive (for DVD version)

Mac OS

•	 Adobe Photoshop* CS5 (including 64-bit) / CS5.1 (including 64-bit) / CS6

•	 Intel processor (Intel Core 2 Duo or better recommended)

•	 Mac OS X 10.6 or higher

•	 4 GB of RAM (8 GB recommended)

•	 300 MB of available hard-disk space

•	 DVD-ROM drive (for DVD version)

*	 Not all foreign language versions of Adobe Photoshop may be supported. Please contact support@avenza.com 
for more information. Also, Adobe Photoshop CS4 is unsupported in this release and it is recommended to use a 
newer version.

†	 For Adobe Photoshop CS5.1 users with Adobe Photoshop CS5 installed (Windows only): when installing 
Geographic Imager 3.5, Adobe Photoshop CS5 may not appear in the installation list. Due to an Adobe 
limitation, choosing to install to Adobe Photoshop CS5 will require you to enable Geographic Imager in the 
Adobe Extension Manager CS5.

System Requirements



15Geographic Imager User Guide
Getting Started

Windows

1.	 Make sure that a compatible version of Adobe Photoshop is installed on your computer. If Adobe Photoshop is 
running, exit the program.

2.	 Ensure that you have administrative privileges for the installation process. If you are unsure whether you have 
the proper privileges, please consult with your IT department.

DVD version: Insert the Geographic Imager DVD into your DVD-ROM drive. If Autorun is disabled on your system, 
navigate to the Geographic Imager for Windows directory on the DVD, and double-click Setup.exe.

Electronic version: Double-click GI40win.zip and extract the contents. When you have unzipped the files proceed 
to the Geographic Imager directory and double-click Setup.exe.

3.	 Proceed through the installation screens as instructed. Note that you will have options to install 
documentation and tutorial data. If you choose to install these components these files can be subsequently 
be found in the \Program Files\Avenza\Geographic Imager directory. Additionally you may access the 
documentation from the Windows Start menu (All Programs > Avenza > Geographic Imager folder).

4.	 Launch Adobe Photoshop. Please proceed to the section on Registration and Licensing on the following page.

Mac OS

1.	 Make sure that you have a compatible version of Adobe Photoshop installed on your computer. If Adobe 
Photoshop is running, exit the program.

2.	 Ensure that you have administrative privileges for the installation process. If you are unsure whether you have 
the proper privileges, please consult with your IT department.

DVD version: Insert the Geographic Imager DVD into your DVD-ROM drive. Navigate to the Geographic Imager for 
Mac directory on the DVD, and double-click Geographic Imager Installer 4.0.pkg.

Electronic version: Mount the GI40mac.dmg file if this operation has not been completed automatically. Then 
proceed to the Geographic Imager 4.0 mounted disk image and double-click Geographic Imager Installer 4.0.pkg.

3.	 Proceed through the installation screens as instructed. Note that documentation and tutorial data may also 
be installed at your option. After installation, these files can be found in the /Applications/Avenza/Geographic 
Imager directory.

4.	 Launch Adobe Photoshop. Please proceed to the section on Registration and Licensing on the following page.

Installation Instructions
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Both single-user fixed licenses and floating licenses of Geographic Imager are available.  

Fixed licenses require activation in order to run. Once activated, they are node-locked or fixed to that particular 
computer based on a unique Machine ID number. Before completing the activation process, be certain that 
Geographic Imager is installed on the intended computer of use.

Floating licenses are designed to allow an organization to deploy a specific number of licenses that can be used and 
shared on any number of computers over a network.

IMPORTANT: Laptop users with a docking station must activate Geographic Imager in the undocked state. All users 
with wireless and fixed NIC’s should disable the wireless NIC temporarily before activating Geographic Imager 
and then activate using a wired internet connection. Other devices such as mobile phones, GPS devices and 
microphones should be disconnected as well.

After installation of Geographic Imager, launch Adobe Photoshop. The Geographic Imager welcome window 
provides four licensing options: Evaluate, Register, Retrieve and Floating. Alternatively, open the License 
Management dialog box from the Geographic Imager panel options menu.

0012345a1234

Geographic Imager License Management

Geographic Imager welcome window

License Management dialog box
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ACTIVATE AN EVALUATION OF GEOGRAPHIC IMAGER

1.	 To activate an evaluation version of Geographic Imager, click the Evaluate button in either the License 
Management dialog box or Welcome Screen. Complete the form and click Evaluate.

Note:	 A Geographic Imager evaluation is fully functional. There are no limitations except that an evaluation license 
is valid for 14 days from the day of activation.

REGISTER A PURCHASED COPY OF GEOGRAPHIC IMAGER

1.	 To register a purchased copy of Geographic Imager, click the Register button in either the License Management 
dialog box or Welcome Screen. Enter the license key that was provided when the product was purchased. 
Complete the form and click Register.

Note:	 The license key for Geographic Imager 4.x starts with "GI4-".
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RETRIEVE A GEOGRAPHIC IMAGER LICENSE

To retrieve an activated Geographic Imager license, click the Retrieve button in either the License Management 
dialog box or Welcome Screen. The license file will be downloaded from the Avenza Systems licensing server.

CHECKOUT A FLOATING LICENSE

If you have purchased a floating license, refer to the floating license installation guide provided with your purchase. 
Once the server license is fully operational, follow these instructions to checkout a license from the client machine 
(computer running the actual Geographic Imager application).

1.	 To setup the floating Geographic Imager license, click the Floating button in either the License Management 
dialog box or Welcome Screen.

2.	 In the Floating License Setup dialog box, enter the name or IP address and port (if specified on the server 
machine) of the server where the license manager resides on the network. Click OK to close it. If the settings 
were correct, the license status should change to Licensed from server in the Welcome Screen.

3.	 Alternatively, in the License Management dialog box or Welcome Screen, click the Checkout button to obtain a 
license from the server. Click the Checkout floating licenses automatically check box if you want a license to be 
checked out whenever Adobe Photoshop is run.

Note:	 Check in a license to release it. This allows other users to use the floating license. The floating license setup 
remembers its settings.
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LICENSE TROUBLESHOOTING

If you cannot register or retrieve an evaluation or purchased license from within Geographic Imager (e.g. firewall 
limitations), visit the Avenza Systems website (www.avenza.com/activation) and provide the Machine ID displayed 
in the License Management dialog box. A zipped license file attachment will be sent to the registered email address 
on record. Unzip this attachment and save the .lic file to the appropriate folder*:

Windows XP: C:\Documents and Settings\All Users\Application Data\Avenza\Geographic Imager
Windows Vista and Windows 7: C:\ProgramData\Avenza\Geographic Imager
Mac OS X: /Applications/Avenza/Geographic Imager/Geographic Imager Plug-In
* English versions only. Location may differ in other Adobe Photoshop language versions.

To quickly access the Geographic Imager license file directory, right-click a row in the License Management dialog 
box and click Browse to license folder. Copy or move Geographic Imager license files directly into this location.

0012345a1234
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The Geographic Imager panel, which provides access to all Geographic Imager tools, appears automatically when 
Adobe Photoshop is first opened (unless it was previously closed). To show or hide the Geographic Imager panel, 
choose Window > Extensions > Geographic Imager

To access the same Geographic Imager tools through the File menu, choose File > Automate.

Geographic Imager Tools
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Geographic Imager 
panel buttons

Georeference detail tabs

Image Mode indicator

Mode indicator

Coordinate System 
information button

Rotation indicator

Geographic Imager 
panel options menu

Reference File and
Coordinate System links

GEOGRAPHIC IMAGER PANEL

GEOGRAPHIC IMAGER PANEL BUTTONS
Georeference: Edit, create, maintain and delete ground 
control points and georeference image files.

Transform: Reproject an image into a different coordinate 
system, change pixel size and modify pixel dimensions.

Mosaic: Assemble multiple images into a larger one.

Tile: Split an image into multiple smaller ones. Channel Management: Adjust color mode and channel roles.

Terrain Shader: Apply a colour gradient or hill shade to a 
digital elevation model or image.

Advanced Import: Import multiple images of various formats 
and adjust image extent, channel management and more.

GeoCrop: Crop images based on location by specifying 
coordinates of the output image.

MORE ABOUT THE REDESIGNED GEOGRAPHIC IMAGER PANEL

The Geographic Imager panel has 
been redesigned and improved. 
Adobe Photoshop CS6 users 
will be able to use the dark user 
interface. The panel behaves 
similarly to other native Adobe 
panels, allowing it to be docked, 
minimized and hidden.
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REFERENCE FILE / COORDINATE SYSTEM LINKS

These links display the location of the geographic reference file of the image and the current coordinate system of 
the image as defined in the Geographic Imager coordinate system database.

Reference File
A geographic reference file contains data that relates the image in pixels to the earth in real world coordinates. 
Along with other parameters, this file contains either the mathematical transformation information or an explicit list 
of reference points and the coordinate system (optional).

Coordinate System
Indicates the current coordinate system of the image. Click the Coordinate System information button to open the 
Geodetic Coordinate System Viewer which shows more detailed information about it.

MODE

The Mode indicator displays information about the image referencing mode. Two modes of referencing are supported: 

Standard Mode
Standard or Normal transformation mode, maintains an affine referencing only. No ground control points are 
maintained. In the Georeference dialog box, the four image corners are calculated for reference. Majority of Adobe 
Photoshop operations are supported in this mode. 

GCP Mode
The GCP (Ground Control Point) mode maintains all ground control points used to reference an image (pixels 
correspond to geographic coordinates). These points are maintained across most Adobe Photoshop operations but 
not through Geographic Imager Transform and Mosaic functions.

IMAGE MODE

The Image Mode indicator displays information about the current image colour mode and bit depth (in bits per 
channel). For example, RGB | 8 means the image colour mode is RGB with 8-bit depth.

ROTATION

The Rotation indicator shows the angle of rotation of the image from north being straight up. A negative value 
indicates a clockwise rotation and a positive value indicates a counterclockwise rotation.
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General
Image Size: The image size in pixels (x by y units).
Image Extents: The geographical extent of the image (x by y units).
Geodetic Extents: The geodetic extent of the image (x by y units).
Pixel Size: The relative size of each pixel (x by y units).

Note:	 Certain world projections may not provide proper values for areas 
outside of the its extents. This may cause the Geodetic Extents to 
display N/A.

Corners
Top Left: The projected coordinate of the northwest corner of the image.
(Long, Lat): The geographic coordinate of the northwest corner of the image.
Bottom Right: The projected coordinate of the southeast corner of the image.
(Long, Lat): The geographic coordinate of the southeast corner of the image.

DEM
Schema Name: Schema used to map elevation data to grayscale color space.
Value Range: Range of values of the current DEM in specified units.
Statistics: Click Calculate to obtain the new elevation range for a cropped DEM.

Notes:	 Hide the Terrain Shader and Shaded Relief Layers before clicking the 
Calculate button. The Statistics calculation may be inaccurate if layers 
above the elevation layer are not hidden. 
 
Statistics are calculated based on what is viewable on the canvas.

Miscellaneous
Geodetic Format: The format used to display world units.
GCP Method: Indicates georeference method and number of points used.

GEOREFERENCE DETAIL TABS
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GEOGRAPHIC IMAGER PANEL OPTIONS MENU

Specify Reference File
Specify a reference file for the current image. See Chapter 3.

Export Reference File
Export the defined coordinate system of an image to a reference file. See Chapter 12.

Specify DEM Schema
Specify a DEM schema for the current image. Opens the Specify DEM Schema dialog box. See Chapter 9. 

Quick Save To Format
Save a referenced image into a Geospatial PDF, GeoTIFF, BigTIFF, NITF, or ECW/ER Mapper. See Chapter 12.

Specify Coordinate System
Specify a coordinate system for the image. Opens the Specify Coordinate System dialog box. See Chapter 3.

Export Coordinate System
Export the coordinate system of the image to a WKT Definition File or Esri PRJ file. See Chapter 9.

Load Custom Coordinate System
Load a custom coordinate system data source. See Chapter 4.

Edit Custom Coordinate Systems
Edit a custom coordinate system data source. See Chapter 4.

Preferences
Adjust Geographic Imager Preferences. See Chapter 14.

Welcome Screen
Opens the Geographic Imager Welcome Screen. See Geographic Imager License Management.

License Management
Opens the Geographic Imager License Management dialog box. View the Machine ID, evaluate, register, retrieve, or 
checkout/in floating licenses. See Geographic Imager License Management.

Check for Updates
Check to see if there is a newer version of Geographic Imager.

Ask Avenza a Question
Opens the Avenza Support page in an Internet browser.

Close
Closes the Geographic Imager panel.

Close Tab Group
Closes the tab group (if the Geographic Imager panel is grouped with at least one other panel).
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Compatibility with Adobe Photoshop

This version of Geographic Imager is compatible with Adobe Photoshop versions CS4, CS5, and CS5.1. If you are 
running multiple versions of Adobe Photoshop on your system, please ensure that you have installed Geographic 
Imager to the appropriate Adobe Photoshop plug-ins folder(s).

The operations of concern are primarily the ones that affect the image size, pixel size and orientation of the 
image. Most of the Adobe Photoshop functions that are involved in these operations, such as Crop, are supported. 
Pixel-level operations, including the majority of plug-ins (e.g. cut and paste), are transparent to Geographic Imager 
and are assumed not to modify georeferencing. These operations are treated as simple image modifications.

Every attempt has been made to ensure compatibility with Adobe Photoshop. Avenza, as third-party developers, 
regrets that due to various limitations within the Adobe Photoshop development environment, certain notifications 
and parameters are unable to be received from several native Adobe Photoshop operations. There are also a limited 
number of procedures within Adobe Photoshop that, when invoked, may adversely affect the georeferencing of 
a spatial image. A warning message will be displayed whenever an operation is performed and may cause data 
loss, render georeferencing invalid, closes a document without saving, or in any other way may silently affect the 
georeferencing of the image document.

UNSUPPORTED FUNCTIONS AND OPERATIONS

The following native Adobe Photoshop functions and operations are not supported by Geographic Imager and may 
damage the georeferencing of an image if performed.

File > Save for Web and Devices
Save for Web and Devices will create a new file without georeferencing.

Image > Reveal All
Reveal is not supported and will result in lost georeferencing.

Image > Trim (Partially supported)
Trim works in modes when pixels are trimmed only in one horizontal and/or one vertical direction (e.g. top and 
left is acceptable, but top and bottom is not). To perform trim for all directions, trim top and left first, followed by 
bottom and right.

Crop Tool (Limitation)
Cropping using perspective or with a set width, height or resolution is not supported and will result in damaged 
georeferencing. Perspective should be unchecked when cropping, click the Clear button to remove set parameters.

Save on application Quit (Mac OS X only)
Due to an existing bug in Adobe Photoshop, modified georeferenced images will not retain spatial referencing 
when quitting the application and saving when prompted. It is recommended to save all modified georeferenced 
files prior to quitting the application.
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UNSUPPORTED AUTOMATE TOOLS: SCRIPTING AND ACTIONS

File > Automate > Batch (Limitation)
When the Destination drop-down list is Folder, the new image will not be georeferenced.

File > Automate > Create Droplet
Results vary on different platforms and operating systems therefore Create Droplet is not fully supported.

File > Scripts > Image Processor
The new file created will not contain georeferencing.

File > Scripts > Script Event Manager
Performing actions or scripts that change the document’s geometry using the Script Event Manager are not 
supported and will not update georeferencing. Instead, run the script from the Actions panel or run it directly 
(choose File > Scripts > Browse).

Action Panel > Insert Menu Item
Insert Menu Item from the Actions panel will create incorrect results with some menu items.

File > Import > Geographic Imager: Advanced Import
Accessing Advanced Import through the File menu is not recordable by an Action.

Document switching (Limitation)
Recording document switching actions (through the Window menu or pressing Ctrl+Tab or Command+Tab) may 
cause incorrect results when using a combination of Geographic Imager tools such as Georeference and Mosaic.

Notes:	 When using any automate tools, Adobe Photoshop must already be open to ensure correct functionality. In 
some cases the script will trigger events before Adobe Photoshop has been initialized and the event will not 
be registered by Geographic Imager. This could result in the georeferencing not being updated. 

If starting a debug session with Adobe ExtendScript Toolkit (by holding the Alt or Cmd (Mac) key during 
Adobe Photoshop startup), Adobe Photoshop will need to be restarted to fully initialize Geographic Imager.

To record Geographic Imager events using ScriptListener or actions, choose File > Automate > Geographic 
Imager [function] instead of using Geographic Imager panel buttons and menu items. Due to Adobe 
Photoshop API limitations, Geographic Imager functions triggered by the panel will not be recorded. 
 
Due to Adobe Photoshop API limitations, Geographic Imager does not automatically read georeferencing 
from a geospatial PDF when it is opened using a script or action.
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OTHER SPECIAL NOTES

The following are some additional compatibility and procedural notes to be aware of in order to properly and 
effectively use Geographic Imager.

Transforming Coordinate Systems
The Transform function creates a transparent background behind the projected image. It is not necessary to flatten 
the image before mosaicking into another image or further transformations.
•	 Transformations always results in a north-up affinely referenced image.

•	 Transformations will convert georeferenced image files from GCP mode to Standard mode.

•	 Multiple transformations may introduce an accumulative loss of precision due to the resampling needed when 
transforming images. It is recommend to transform images only once to the final source coordinate system. To 
avoid this problem, keep a copy of the original image if it will be needed in another coordinate system.

•	 In order for Geographic Imager to interpret all transformation parameters it may be necessary to maintain the 
ArcGIS exported AUX file and store it in the same location as the ARC generated GeoTIFF file. Not including the 
AUX file may result in WKT parsing errors.

•	 An image transformed into Azimuthal Equidistant (spherical) may be recognized as "none" when opened in 
ArcGIS because of a conflict between the ellipsoidal and spherical datums. Furthermore, when an image in 
WGS84 is transformed into WGS84/Azimuthal Equidistant in ArcGIS, it actually uses a spherical datum.

Georeferencing
•	 Geographic Imager continuously maintains the proper georeferencing information for all georeferenced image 

files throughout the duration of the Adobe Photoshop session, as well as during a Save procedure. Documents 
may become implicitly georeferenced upon the file open process if Geographic Imager can locate proper 
georeferencing information (reference file with same name as opened image).

•	 New documents created within Adobe Photoshop are never georeferenced unless they are based on 
georeferenced documents. However, in cases where a new document has been created, a reference file for the 
newly created document may be specified or created using Geographic Imager.

•	 Coordinate system information can not always be stored in the reference file. World files only contain image 
reference data and will never maintain the coordinate system. Some projections and coordinate systems are 
not supported in GeoTIFF. MapInfo TAB files also contain the same limitation and in absence of the coordinate 
system information some MapInfo-based program may in fact assume WGS 84 Coordinate System. ER Mapper 
ERS files must contain an ER Mapper identifier within the coordinate system definition to save the coordinate 
system with the file. See Chapter 2 - Georeference Formats for more information.

•	 Compatibility issues may occur when the image is not in Standard mode, is not north-oriented or the 
coordinate system direction is reversed, since certain legacy applications may not provide proper support for 
non-trivially referenced imagery.

•	 While some Adobe Photoshop operations are supported in GCP mode, we recommend using it only for image 
rectification and suggest otherwise starting from/switching to Standard referencing mode prior to performing 
any Adobe Photoshop operations.

•	 Blue Marble RSF and MapInfo TAB files save the complete reference (point list information) so that it can 
be loaded again in the future. Esri world files contain a computed relationship between the source image 
coordinates and the reference coordinates and not the complete reference point information, therefore, 
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reference points cannot be reloaded from an Esri World file. When an Esri world file is loaded into the reference 
point list the four corners of the source image are recalculated using the world file parameters, and displayed 
as reference points. If you’d like to keep the original point list, it is recommended to save a MapInfo TAB file 
when in GCP mode so that the raw reference point information can be recalled at a later date.

Color Modes
•	 Only RGB, CMYK, Grayscale, Duotone and Lab Colour modes are supported by all Geographic Imager 

operations including georeference, save and export, transform, mosaic, and tile.

•	 Support for the various image colour modes available within Adobe Photoshop are identical across the various 
functions and operations available in Geographic Imager except as indicated below.

•	 Support for transforming 32-bit per channel images is currently limited while work continues to expand 32-bit 
per channel support within Geographic Imager. User experiences may vary depending upon image sources 
and workflows. Contact Avenza for more details.

•	 With colour modes that are not supported by all of Geographic Imager operations, the bit per channel  
information will not be displayed on the panel (e.g. Bitmap, Indexed colour and multichannel) and the 
appropriate buttons will be disabled.

Mosaicking
•	 Adobe Photoshop allows for duplicate layer names. Therefore, if an image is mosaicked multiple times new 

layer groups will be generated with the same name within Adobe Photoshop.

Adobe Photoshop start-up
•	 It is not recommended to use Alt+Tab keyboard command (Option + Tab for Mac) to switch between programs 

during Adobe Photoshop start-up. Geographic Imager runs a series of scripts that can be interrupted by the 
Adobe Photoshop debugging tool if this command is used. Using these keys during start-up may interrupt 
normal application execution and even cause the application to appear unresponsive.

Save Adobe PDF
•	 Modifying settings in the Save Adobe PDF dialog box may trigger error messages or may generate a corrupt 

PDF file. It is recommended to use Quick Save To Format. If necessary, use Adobe Acrobat to adjust PDF 
document properties (e.g. description, security, etc.).

Saving documents in background (CS6 only)
•	 Adobe Photoshop CS6 has the ability to save documents in the background. Geographic Imager supports 

this feature, however, georeferencing may not be stored when saving a document "as a copy". This may affect 
additional third-party format writers and the Adobe JPEG2000 writer. If you’re experiencing Geographic Imager 
warnings about reference not being stored, you may want to: 1) change your workflow to avoid renaming files 
on save; 2) choose a different file format; or 3) disable saving in background (Preferences -> File Handling).
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RESET ADOBE PHOTOSHOP PREFERENCES

If you experience uncommon or abnormal results with Adobe Photoshop, try deleting the Adobe Photoshop 
preference file, Adobe Photoshop [CS version] Prefs.psp. To quickly do this, hold Ctr+Alt+Shift (Option+Command+Shift for 
Mac) keys immediately on Adobe Photoshop start-up. Or manually delete the preference file. A new preference file 
will be generated the next time Adobe Photoshop is run. The preference file is located in:

Windows XP
C:\Documents and Settings/[Username]/Application Data/Adobe/Adobe Photoshop [CS version]/Adobe Photoshop [CS version] Settings

Windows Vista and Windows 7
C:\Users\[Username]\AppData\Roaming\Adobe\Adobe Photoshop [CS version]\Adobe Photoshop [CS version] Settings

Mac OS X
/Users/[Username]/Library/Preferences/Adobe Photoshop [CS version] Settings

Note:	 For Adobe Photoshop x64 [CS version] users, the preference file is called Adobe Photoshop X64 [CS version] Prefs.psp.
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MAPublisher for Adobe Illustrator
Every effort has been made to ensure that images exported from Adobe Photoshop using Geographic Imager are 
fully compatible with Adobe Illustrator using MAPublisher. However some features within Adobe such as channels 
are not supported and should be avoided when creating images for use with MAPublisher.

The two environments employ slightly different methods for handling, encoding, and reading GeoTIFF headers 
and world files. In some rare instances, the georeferencing data created by Geographic Imager may be incorrectly 
interpreted by MAPublisher. In severe cases, the image may not be properly registered within Adobe Illustrator even 
after being recognized as a GeoTIFF. It is recommended to export a world file from Geographic Imager and use it for 
image registration in MAPublisher if GeoTIFF proves difficult or unsuccessful.

The Adobe Photoshop Export > Paths to Illustrator function creates an Adobe Illustrator file. To achieve compatibility 
with MAPublisher, Geographic Imager creates an RSF file upon export. Use the New MAP View for Photoshop Paths in 
MAPublisher to create a new MAP View based on the exported Adobe Illustrator file and RSF.

Other Third-party Plug-ins
All efforts have been made to develop and engineer Geographic Imager in accordance with the Adobe Photoshop 
SDK and third-party development schema. However, Avenza cannot verify and validate compliance and 
compatibility with other third-party plug-in products that may be installed on any particular system and cannot 
guarantee that the use of Geographic Imager will perform as expected in such environments and will not clash with 
other plug-ins. Furthermore, Avenza can neither confirm nor guarantee that the use of any particular third-party 
plug-in, action or script will not damage the georeference data of any spatial image in use with Geographic Imager. 

When third-party plug-ins are installed to read the same files as Geographic Imager, conflicts in reading image 
formats may occur. It is recommended to disable or remove third-party plug-ins before using Geographic Imager.

The use of any other third-party plug-in that in any way alters the geometry of a georeferenced image will damage 
the georeferencing of the image due to the fact that Geographic Imager has no way of knowing a) that the other 
plug-in exists; b) that it has been invoked; and c) what it has actually done to the image.

In most instances third-party plug-ins that do not alter the geometry of the image will not have an adverse effect 
on image georeference data.

Compatibility with MAPublisher 
and Other Applications
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Uninstall Instructions

Windows

1.	 If Adobe Photoshop is running, exit the program.

2.	 Click the Start button, point to All Programs, click Avenza, click Geographic Imager and click Uninstall.

3.	 If the User Account Control dialog box appears, click Allow.

4.	 In the Geographic Imager Uninstall Confirmation dialog box, click Uninstall.

5.	 A message prompts that all files will be removed from the Geographic Imager program folder. To save custom 
XML datasource files in the Applications folder, click Yes. To delete them, click No.

Mac OS

1.	 If Adobe Photoshop is running, exit the program.

2.	 In Finder, browse to the directory /Applications/Avenza/Geographic Imager/

3.	 To save the custom XML datasources, move the Data Source Backup folder to a different location.

4.	 Delete the entire Geographic Imager folder or delete only the Geographic Imager Plug-In folder to keep the 
other files (documentation, tutorials, etc.).

5.	 To complete the uninstall, open Adobe Extension Manager CS5/CS5.5/CS6, click Photoshop in the Products list, 
click the Geographic Imager extension and click the Remove button.

If Geographic Imager is already installed, the installer application will attempt to uninstall it first. This applies to 
Adobe Photoshop CS5 and above.
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The key to Geographic Imager is its ability to recognize and 
maintain the geographic structure of a spatial image. Spatial 
images or georeferenced files are rasters that carry a set of 
geographic information that indicates the exact location 
of the image in the real world along with the scale of the 
image relative to the earth. This "reference data" can exist as a 
separate external reference file or as header information built 
into a TIFF image, which constitutes a GeoTIFF.

This section provides an overview of:
Supported Reference Formats
Supported DEM Formats
Other Supported Raster Formats

Spatial Image 
Formats
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Any image format that can be opened and displayed by Adobe Photoshop can form the basis for a spatial image. 
This includes, but is not limited to, the following common formats: *.tif, *.jpg, *.bmp, *.psd, *.gif, *.png. Please refer 
to the Adobe Photoshop user guide for a complete list of the file formats supported by Adobe Photoshop.

Additional formats are available after Geographic Imager is installed. See Supported DEM Formats and Other 
Supported Raster Formats.

In order to be a spatial or geographically referenced image (rather than just a plain photograph or scan) there must 
be an associated reference file or reference header that details the position and scale of the image relative to the 
real world. Refer to Default Reference Formats in Chapter 11 of this user guide.

Please note that although any image, in any colour mode, can be georeferenced and recognized by Geographic 
Imager, the performance of some Geographic Imager functions are restricted to certain colour modes/bit depths.

Note:	 Opening any files over a cross platform network may increase load times.

SUPPORTED REFERENCE FORMATS

World File (*.tfw, *.tifw, *.wld, *.jgw, *.pgw, *.sdw, *.eww, *.blw, *.dmw, *.ers) 
Read and Write

World files contain the affine relationship between source image coordinates (pixel locations) and real-world 
reference coordinates (lat/long or other real-world coordinate units). World files simply contain a computed 
relationship between source image coordinates and reference coordinates. It consists of the pixel sizes in x and y 
direction, rotations about x and y axis and x and y coordinates of the center of the upper left pixel. Reference points 
cannot be loaded from a world file because they do not exist in the file. When in GCP mode, it is recommended that 
a reference file in any GCP points supporting format also be exported to TAB or RSF so that any raw reference point 
information can be recalled at a later date. World files do not support storing coordinate system information. You may 
export the coordinate system information as an external WKT or PRJ file using the Export Coordinate System function.

Blue Marble Reference File (*.rsf)
Read and Write

The Blue Marble Reference Settings File saves the complete reference point list information such that it can be 
loaded again in the future. Within a Blue Marble Reference File, the first line contains the version of the file format 
(not to be confused with the version of the software) and the total number of points in the file. The remaining lines 
contain, in each line, the point ID, the x (row) pixel, the y (column) pixel, the z (elevation) value which is usually 0.00, 
followed by the ground coordinates expressed as Latitude or Northing (Y), Longitude or Easting (X) and Elevation 
(Z). The last value indicates whether the point described on that line is included in the solution, 0 = not included 
and 1 = included. Blue Marble Reference files support storing coordinate system information and GCPs.

Spatial Image Formats
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MapInfo TAB File (*.tab)
Read and Write

MapInfo Table file formats save the complete reference point list information such that it can be loaded again in the 
future. MapInfo TAB files support storing coordinate system information and GCPs.

Supported projections when saving a coordinate system to TAB:

Albers Equal-Area 
Azimuthal Equidistant 
Hotine Oblique Mercator
Hotine Oblique Mercator 1pt
Lambert Conic Conformal

New Zealand Map Grid
Polyconic 
Swiss Oblique Mercator
Stereographic Transverse Mercator

ER Mapper Raster File (*.ers)
Read and Write

The ER Mapper header file is an ASCII file describing the raster data in the data file. The entire header file holds 
information about the data source and is contained in the DatasetHeader block. There are two compulsory 
sub-blocks, the CoordinateSpace block (to define the coordinate space and location) and the RasterInfo block (to 
define the characteristics of the data in the accompanying data file). The RasterInfo block my contain a number of 
optional sub-blocks. To completely define coordinate information in an ER Mapper header file you need to include 
the following data: datum, projection, coordinate type, units, X and Y dimensions for cell size, registration cell X and 
Y values, registration cell coordinates, and possibly null cell value. Coordinate information is frequently, but not 
always, given for the upper left corner of an image. This would be registration cell X and Y values of 0.0 and 0.0. For 
most projections registration coordinates are entered as eastings and northings, the coordinate type will be "EN", 
and units will be meters (or occasionally feet). If you are using latitude and longitude the projection is Geodetic, 
coordinate type will be "LL" and the X and Y dimensions for the cell size will be in decimal degrees.

ER Mapper files support storing a limited number of pre-defined coordinate systems. Check the coordinate system 
details to ensure the ER Mapper identifier exists as the issuer for the coordinate system to be saved. The file will still 
be exported however the coordinate system will not be saved with the reference file.

Note:	 ER Mapper reference files do not support rotated images. When attempting to export a reference file with a 
rotated image ER Mapper will not be listed.

Adobe Geospatial Portable Document Format, TerraGo GeoPDF® (*.pdf)
Read and Write

The geospatial PDF is considered an Adobe Acrobat Portable Document Format (following the PDF 1.7 specification) 
that contains information that is required to georeference location data. It is an open specification developed and 
maintained by Adobe Systems. See detailed specifications in Section 8.3 at http://www.adobe.com/devnet/acrobat/
pdfs/PDF32000_2008.pdf. The TerraGo GeoPDF is a proprietary format that is compatible with Geographic Imager , 
but with limitations.

Note:	 The Adobe PDF file format cannot reference non-PDF images; it can only reference other PDF images.
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GeoTIFF File (*.tif, *.tiff)
Read and Write

Tagged Image File Format (TIFF or TIF) is a common raster graphic file format and one of the most common 
geospatial image formats (in the form of GeoTIFF). A GeoTIFF is a TIFF file with embedded geographic information 
such as position and scale in world coordinates, affine transformation or an explicit list of GCP points. Many raster 
geographic images from GIS systems are stored in this format.

Unlike other georeferenced image formats discussed in this section, a GeoTIFF does not require a separate reference 
file. Geographic information is automatically detected when a GeoTIFF is opened in Geographic Imager. When 
saving a georeferenced image to the *.tif or *.tiff format, Geographic Imager writes the appropriate georeference 
header information into the file. GeoTIFF files also support storage of coordinate system information and GCPs.

Supported projections when saving a coordinate system to GeoTIFF:
Albers Equal-Area Conic
Azimuthal Equidistant
Cassini-Soldner
Cylindrical Equal Area
Eckert IV
Eckert VI
Equidistant Conic
Equidistant Cylindrical
Equirectangular
Gall Stereographic
Gnomonic
Hotine Oblique Mercator
Laborde Oblique Mercator

Lambert Azimuthal Equal Area
Lambert Conic Conformal (1SP)
Lambert Conic Conformal (2SP)
Lambert Conic Conformal (2SP Belgium) 
Lambert Cylindrical Equal Area
Mercator
Miller Cylindrical
Mollweide
New Zealand Map Grid
Oblique Mercator 
Oblique Stereographic
Orthographic
Polar Stereographic

Polyconic
Robinson
Rosenmund Oblique Mercator
Sinusoidal 
Stereographic
Swiss Oblique Cylindrical
Swiss Oblique Mercator
Transverse Mercator
Transverse Mercator (modified Alaska)
Transverse Mercator (South Oriented)
Tunisia Mining Grid
VanDerGrinten

Notes:	 - Geographic Imager supports every coordinate system it can write, regardless of projection. However, this 
does not guarantee that a third-party GIS software will recognize all coordinate systems or projections. 
- When a GeoTIFF contains rotation, is in GCP mode, or the coordinate system direction is reversed, it may not 
open in legacy applications. 
- Multichannel images are not supported using Geographic Imager Quick Save To Format (GeoTIFF). 
- It is recommended to open 12-bit TIFF images with Advanced Import, otherwise it won’t open.

DATA CONSIDERATIONS AND LIMITATIONS

When obtaining spatial imagery for use with Geographic Imager, whether from an online source, commercial vendor, 
government office or a source within your organization, there are a number of important considerations to keep 
in mind. Try to obtain data in one of the formats supported by Adobe Photoshop. Use the File > Open command to 
view the list of reference files supported by Geographic Imager. In cases where the file format native to a particular 
mapping application is not supported by Geographic Imager or Adobe Photoshop, you can often request the data 
provider to export a file in one of the supported formats.

When obtaining data, acquire as much metadata as possible. If an image is received in any format other than 
GeoTIFF, obtain a reference file in one of the formats supported by Geographic Imager. It is important to obtain the 
name of the projection, the datum and the units because subsequent reprojection of data relies on this information.

TIFF and BigTIFF files opened using GeoCrop Import do not support layers, text and other Adobe Photoshop 
specific image features at this time. Generally, satellite imagery would not contain any of these features which are 
added by using Adobe Photoshop. TIFF files (up to 2 GB in CS4) that are opened using just Adobe Photoshop (e.g. 
not GeoCrop) are not affected.
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VIEWING GEOSPATIAL PDF FILES

Geospatial PDF files are compatible with the geospatial tools in Adobe Acrobat 9 and newer. The availability of 
these tools depends on the Acrobat version (Reader, Standard, Pro, or Pro Extended [Adobe Acrobat 9 only]), but no 
additional Acrobat plug-in is necessary to view a geospatial PDF. 

All traditional Adobe Acrobat tools apply with the following being the most relevant:
•	 Search: select objects with matching name first, then objects that have a matching attribute value. 
•	 Acrobat Layers panel: displays all layers and controls the display and lock of the layers.
•	 Object Data Tool: select map objects and display their attributes in the Adobe Acrobat Model Tree 

(Structure Pane and Object Data Pane).

Geospatial PDF files can also be read in Adobe Acrobat 8, however, the attribute information is only accessible 
(through the menu Tools > Object Data > Object Data Tool) and it does not have the geospatial tools that are 
available in version 9 or newer.

Adobe Acrobat has the following special tools to access geospatial information:
•	 Measuring Tool: measure distance, area and perimeter.
•	 Geospatial Location Tool: display, mark and query geospatial locations.
•	 Geospatial Registration Tool: spatially register a PDF document by digitizing control points (Adobe Acrobat 

9 Pro Extended only).

These tools and the Object Data Tool are found on the Analysis Toolbar (menu View > Toolbars > Analyze).

Object Data Tool - Enable selection of MAP 
objects and display name and information in 
the Adobe Acrobat Model Tree (menu View > 
Navigation Panels > Model Tree).

Measuring Tool - Measure 
distance, perimeter and area.

Geospatial Location Tool 
Display, mark and query geospatial locations. 

Preferences for the Measurement and Geospatial tools are found in the menu Edit > Preferences, under the category 
Measuring (Geo).
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These analysis tools are described in detail in the Adobe Acrobat documentation that can be found under the 
Adobe Acrobat menu Help > Adobe Acrobat Help or on the Adobe Website www.adobe.com.

Not all tools are available for every Adobe Acrobat version, below is a matrix showing the features availability per 
Adobe Acrobat version:

Acrobat version Reader 9 and newer Standard  and Pro 
9 and newer

Acrobat 9 Pro 
Extended

(Windows only)

Geospatial Measuring Tool

Measure distance/perimeter/area PÛ P P
Store measurements as comments PÛ P P
Export/import PDF comments PÛ P P
Geospatial Location Tool

Show on-screen coordinates P P P
Search for/zoom to a location P P P
Mark location with right click O P P
Copy coordinates to clipboard O P P
Geospatial PDF Registration Tool

Create from GeoTIFF/JPG2000 O O P
Georegister a PDF map/image O O P
Add shapefile layers to a map O O P

* To enable the measurement tool in Acrobat Reader 9, the file must first be opened in Acrobat Standard, Pro or Pro 
Extended to enable annotations on the PDF (menu Comments > Enable for commenting and analysis).

Notes:	 The extended tools of Adobe Acrobat Pro Extended are not necessary for MAPublisher users because these 
functions can be performed by MAPublisher. Adobe Acrobat Pro Extended is currently not supported for Mac 
operating systems. 
 
By default, viewing coordinates with the Geospatial Location Tool will show latitude and longitude in WGS84 
when the Always display latitude and longitude as WGS 1984 option is enabled in Adobe Acrobat preferences. 
A map with a geodetic base other than WGS84 should have the Always display latitude and longitude as WGS 
1984 option unchecked.
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SUPPORTED DEM FORMATS

ArcInfo ASCII Grid (*.agr, *.grd, *.txt, *.asc)
Read only

ArcInfo ASCII Grid refers to a specific interchange format developed for ArcInfo rasters in ASCII format. The format 
consists of a header that specifies the geographic domain and resolution, followed by the actual grid cell values. Usually 
the file extension is .asc, but recent versions of Esri software also recognize the extension .grd.

ArcInfo Binary Grid (*.adf)
Read only

dblbnd.adf
hdr.adf
log

prj.adf
sta.adf
vat.adf

w001001.adf
w001001x.adf

The ArcInfo Binary Grid is formed from a set of the files contained in a directory (listed above). When loading a raster 
into ArcGIS, it sees the containing directory as a single DEM, not as a directory containing other files. Due to software 
limitations, Geographic Imager does not see the whole directory as a single DEM and instead requires that the 
appropriate *.adf file to be selected for use (navigate to the directory containing w001001.adf file).

ArcInfo Binary Float Grid (*.flt)
Read only

The ArcInfo Binary Fload Grid is a binary file that stores floating point data (topological elevation values) line by line from 
north to south. It must be used with an accompanying header file (.hdr) that contains the georeferencing information 
(both files must be stored in the same directory to function).

BIL (*.bil)
Read only (can be opened as raster with color file)

The BIL format, meaning "band interleaved by line", is an uncompressed file containing the actual pixel values of 
an image. Pixel information is stored in separate bands within the file. It is possible to display one specific band in a 
multi-band BIL image. BIL files can consist of black and white, grayscale, pseudocolor, true color, and multi-spectral 
images. There are four image description files (ASCII text file format) that can accompany a BIL file: a header file, a 
statistics file, a resolution file, and a color file.

The header file (.hdr) provides a description of the data through the use of keywords and values. The statistics 
file (.stx) is an optional file that describes the image statistics for each spectral band. It records the minimum and 
maximum pixel values, the mean, the standard deviation, and the two linear contrast stretch parameters.  The 
resolution file (.blw) describes the height and width of each cell and the coordinate position of the top left cell of 
the data.  The color file (.clr) is an optional file that describes the image colormap.

Note:	 Renaming a BIL file with an extension of .dem will cause incorrect results when opened.
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ERDAS IMAGINE DEM (*.img)
Read only

ERDAS IMAGINE uses .img files to store raster data. These files use the ERDAS IMAGINE Hierarchal File Format (HFA) 
structure. A tiled format is used to store raster layers. This allows raster layers to be displayed and resampled quickly. 
Each raster layer within a .img file has its own ancillary data, including the following parameters: height and width (rows 
and columns), layer type (continuous or thematic), data type, compression, and lock size.

USGS SDTS (*.ddf)
Read only

The Spatial Data Transfer Standard (SDTS) is a robust way of transferring earth-referenced spatial data between dissimilar 
computer systems with the potential for no information loss. It is a transfer standard that embraces the philosophy 
of self-contained transfers, i.e. spatial data, attribute, georeferencing, data quality report, data dictionary, and other 
supporting metadata all included in the transfer.

USGS ASCII DEM / CDED (*.dem)
Read only

This is the traditional format used by USGS before being replaced by SDTS, and is the format used for CDED DEM 
data products from the Canada. Most popular variations on USGS DEM files should be supported, including correct 
recognition of coordinate system, and georeferenced positioning.

The USGS Digital Elevation Model (DEM) data files are digital representations of cartographic information in a raster 
form. DEMs consist of a sampled array of elevations for a number of ground positions at regularly spaced intervals. These 
digital cartographic/geographic data files are produced by the U.S. Geological Survey (USGS) as part of the National 
Mapping Program and are available in 7.5-minute, 15-minute, also known as 30-minute and 1-degree units. The 7.5- 
and 15-minute DEMs are included in the large scale category while 30-minute DEMs fall within the intermediate scale 
category and 1-degree DEMs fall within the small scale category.

Military Elevation Data / DTED (*.dt0, *.dt1, *.dt2)
Read only

The National Geospatial-Intelligence Agency (NGA) developed a standard digital dataset called the Digital Terrain 
Elevation Data (DTED®). It is a dataset of terrain elevation values that provides basic quantitative data for systems and 
applications that require terrain elevation, slope, and/or surface roughness information. DTED datasets come in three 
levels: Level 0, Level 1 and Level 2.

DTED Level 0 elevation post spacing is 30-arc-second (nominally one kilometer). DTED Level 0 was derived from NGA 
DTED Level 1 to support a federal agency requirement. DTED Level 1 is a uniform matrix of terrain elevation values with 
post spacing every 3-arc-seconds (approximately 100 meters). The information content is approximately equivalent 
to the contour information represented on a 1:250,000 scale map. DTED Level 2 is a uniform gridded matrix of terrain 
elevation values with post spacing of one-arc-second (approximately 30 meters). The information content is equivalent 
to the contour information represented on a 1: 50,000 scale map.
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SRTM (*.hgt)
Read only

SRTM is an international project spearheaded by the National Geospatial-Intelligence Agency (NGA) and the National 
Aeronautics and Space Administration (NASA). Digital elevation models of the earth’s surface were created with 
measurements derived from the return signals received from two radar antennae on a spacecraft. Each data file covers a 
one-degree-of-latitude by one-degree-of-longitude block of the earth’s surface. SRTM consisted of a specially modified 
radar system that flew on board the Space Shuttle Endeavour during the 11-day STS-99 mission in February 2000, based 
on the older Spaceborne Imaging Radar-C/X-band Synthetic Aperture Radar (SIR-C/X-SAR).

OTHER SUPPORTED RASTER FORMATS

Web Map Service
Read only

Web Map Service is an interface standard designed by the Open Geospatial Consortium (OGC) for GIS raster data
transactions through http protocol. The Geographic Imager WMS import connects to servers that use version 1.1.1 
of the OGC standard. WMS data formats include TIFF, GIF, PNG, and JPEG. See Chapter 11 - Advanced Import.

BigTIFF (*.tif, *.tiff)
Read and Write

BigTIFF extends the original TIFF file format specification to support 64-bit (for images larger than 4 GB). It is the 
result of work by a variety of parties including Adobe Systems. BigTIFF is expected to be useful for people and 
vendors that are confronted with unusually large images and still seek to use an open, simple, and extendable 
format. BigTIFF is not yet an official standard and is still awaiting final approval.

There is different behaviour between Windows and Mac OS X when opening BigTIFF files:
•	 Windows: BigTIFF is enabled for all TIFF files.
•	 Mac OS X: BigTIFF is only enabled files for files over 2 GB. 

ERDAS IMAGINE Raster (*.img)
Read and Write

ERDAS IMAGINE uses .img files to store raster data. These files use the ERDAS IMAGINE Hierarchal File Format (HFA) 
structure. A tiled format is used to store raster layers. This allows raster layers to be displayed and resampled quickly. 
Each raster layer within a .img file has its own ancillary data, including the following parameters: height and width (rows 
and columns), layer type (continuous or thematic), data type, compression, and lock size.

Enhanced Compression Wavelet (*.ecw)
Read and Write

ECW is a proprietary wavelet compression image format optimized for aerial and satellite imagery. It was originally 
developed by Earth Resource Mapping. The lossy compression format efficiently compresses very large images with fine 
alternating contrast.



42 Geographic Imager User Guide
Spatial Image Formats

JPEG 2000 (*.jp2, *.j2k,*.jpx,*.jpc,*.j2c,*.jpf)
Read only

JPEG 2000 is a wavelet-based image compression standard. It was created by the Joint Photographic Experts Group 
committee in the year 2000 with the intention of superseding their original discrete cosine transform-based JPEG 
standard (created 1992). The standardized filename extension is .jp2 for ISO/IEC 15444-1 conforming files and .jpx for the 
extended part-2 specifications, published as ISO/IEC 15444-2, while the MIME type is image/jp2.

Note:	 For Adobe Photoshop CS5 users, if JPEG 2000 files open incorrectly, try using Geographic Imager Advanced Import.

LizardTech MrSID and MrSID/MG4 LiDAR (*.sid)
Read only

Multi-resolution Seamless Image Database (MrSID) is a powerful wavelet-based image compressor, viewer and 
file format for large raster images. Developed by LizardTech Inc., MrSID enables instantaneous viewing and 
manipulation of images locally and over networks. Features include high and efficient compression ratios while 
maintaining true multiple resolutions, selective decompression, seamless mosaicking and browsing. MrSID/MG4 is a 
wavelet-based point-cloud compression technology. Files in the MrSID/MG4 compressed LiDAR file can be opened 
and viewed as a raster DEM.

NITF (*.ntf)
Read and Write

The National Imagery Transmission Format (NITF) data format is widely used by geospatial analysts in the defense 
and intelligence communities. The NITF format contains imagery and associated metadata in a single file.

PCI EASI/PACE (*.pix)
Read only

PCIDSK database file used by PCI EASI/PACE software for image analysis. All pixel data types, and data organizations 
(pixel interleaved, band interleaved, file interleaved and tiled) should be supported, but compressed PCIDSK files 
are not supported. Currently LUT and PCT segments are ignored. Overall file, and band specific metadata should be 
correctly associated with the image or bands. Georeferencing is supported though there may be some limitations 
in support of datums and ellipsoids. If GCP segments are present, the first will be used, and the rest ignored. Internal 
overview (pyramid) images will also be correctly read though newly requested overviews will be built externally as 
an .ovr file.

SGI Image Format (*.rgb)
Read only

The SGI image file format is part of the SGI image library found on Silicon Graphics machines. The driver currently 
supports 1, 2, 3, and 4 band images. The driver currently supports "8 bit per channel value" images. The driver 
supports both uncompressed and run-length encoded (RLE) images for reading, but created files are always RLE 
compressed.



43Geographic Imager User Guide
Spatial Image Formats

DEM DATA CONSIDERATIONS, LIMITATIONS AND GENERAL INFORMATION

Geographic Imager imports DEM files into Adobe Photoshop as grayscale 16-bit files. Currently, Geographic Imager 
cannot save to DEM formats and any changes must be saved in one of the other formats available (GeoTIFF, etc).

The Raw Data DEM Schema creates a potentially low-contrast image and keeps the source elevations directly 
mapped to actual pixel values. In addition, there is mosaicking support for images of the same DEM schema.

Adobe Photoshop functions currently applicable to the manipulation of DEM files are based on the pixel RGB values 
rather than the actual DEM heights (e.g. the gradient maps or lighting effects, see Supplemental Adobe Photoshop 
Tutorial Guide for examples on the use of these functions). 

To view DEM values, use the Adobe Photoshop Histogram panel (choose Window > Histogram). It provides 
information on the pixel value distribution which is directly related to the DEM height distribution. The color 
picker tool (switch to 16-bit display in the Histrogram panel) can be useful for Raw images, despite certain level of 
approximation used by Adobe Photoshop for displaying the values. Another way to view DEM values is to use the 
Georeference dialog box. The elevation value is displayed below the preview image.

More advanced functions are planned for future releases of Geographic Imager.

Known Adobe Photoshop Limitations

Select > Color Range
The preview is based on an 8-bit image. The actual selection on a 16-bit image may be different from the preview.

Magic Wand tool
This tool makes a selection based on an 8-bit image, even if the image is in 16-bit mode. It is preferable to select by 
Color Range.

Filter > Render > Lighting Effects
This filter only works on 8-bit images. Converting an imported DEM from 16-bit to 8-bit incurs data loss in height 
resolution, therefore this filter should be used at the end of a workflow.

Gradient Map Adjustment Layer
A gradient map adjustment layer can be used to colorize a DEM. Adobe Photoshop uses the gray scale value of 
every pixel to assign a new color. This means that the gradient map is scaled to (0 to 100) the DEM elevation range. 
Applying the same gradient map to two separate DEM files will give different colours to the same elevation values. 
This must be taken into consideration before using the Geographic Imager Mosaic function.

FUTURE SUPPORTED FORMATS

If you are interested in having a particular format be supported in Geographic Imager for Adobe Photoshop, please 
contact us and we’ll be happy to consider it.





45Geographic Imager User Guide
Open Geographic Imagery

The ability to automatically recognize georeferenced 
images is at the foundation of Geographic Imager. 

Opening a spatial image is the main starting point for 
most users wanting to work with Geographic Imager in 
Adobe Photoshop.

Geographic Imager supports all the image formats 
supported by Adobe Photoshop as discussed in Chapter 2.

This chapter provides information on how to open a 
spatial image, select and apply a reference file and select 
and apply a coordinate system. 

Topics covered in this section:
Open an Image
Specify Reference File
Specify a Coordinate System

Open 
Geographic 
Imagery
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OPEN AN IMAGE

The first step in working with spatial imagery is to open an image file. 
There are several methods to open images: 
•	 from the Adobe Photoshop menu choose File > Open command

•	 double-click an image in operating system file browser

•	 by drag-and-drop (drag file to the application icon).

SPECIFY REFERENCE FILE

Geographic Imager automatically recognizes an image as being georeferenced or not. A reference file (e.g. TFW) 
needs to be in the same folder as the image to be automatically recognized. When a file is recognized as a 
geographic image, the Geographic Imager panel displays the name of the reference file and the contents of it: the 
northwest (top left) and southeast (bottom right) corner coordinates, image size, pixel size and rotation angle. Units 
are not indicated if no coordinate system is specified.

If a reference file is not found, it may be necessary to manually specify one. In order to specify a reference file, click 
the Reference File Specify link in the Geographic Imager panel. Alternatively, in the Geographic Imager panel options 
menu, choose Specify Reference File. In the Choose a Reference File dialog box, browse and select a reference file of 
one of the supported formats listed in the File Type drop-down list. Once a reference file is specified, changes to 
an image’s referencing are reflected in the reference file. Changes to this file are automatically saved whenever the 
image itself is saved.

If multiple reference files matching the image name are located in the same folder, the user will be prompted to 
choose one of them to be used for georeferencing purposes. Any changes in document georeferencing will be 
stored automatically in the current reference format.

If no reference file is available but a set of point coordinate locations are known (such as the Top Left corner and 
Bottom Right corner coordinates), a custom reference file can be created. See Chapter 8 - Georeferencing.

Open Geographic Imagery
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SPECIFY A COORDINATE SYSTEM

In order to transform an image, Geographic Imager needs to know the current coordinate system of it. If the 
coordinate system information is not present in the image reference file, it is necessary to specify a one. To do this, 
click the Coordinate System hyperlink in the Geographic Imager panel or choose Specify Coordinate System from the 
panel options menu.

The Specify Coordinate System dialog box contains three methods to set the coordinate system: From File, Same 
As and Specify. To set the coordinate system based on a reference file, click the From File button. The Import Source 
Coordinate System From File dialog box appears. Choose an existing reference file.

To set the coordinate system to be the same as that of another open image with a coordinate system, select the 
Same As option and then the desired image to match from the drop-down list. This option is greyed out if there are 
no other referenced images open.

To find more information about the file, click the View coordinate system information button (when enabled). To 
remove a coordinate system from an image, click the Clear current coordinate system button (when enabled). Note 
that an image can not be transformed when the coordinate system is unknown.

To set a coordinate system from the Geographic Imager data source, click the coordinate system hyperlink. The Specify 
Source Coordinate System dialog box appears and displays the contents of the current coordinate system database. 

Search Folder
Search based on the 

selected folder

Custom Data
Displays the currently 

loaded user-defined data 
source (read-write)

Category Folders
Folders containing  

Geodetic and Projected 
coordinate systems

Find 
Enter search keyword

Datasource
Displays the default data 

source (read-only)

Search 
Search for a coordinate 
system using these options 

Search List 
Contains a list of columns to 
search relative to the selected 
category

Edit Categories Buttons 
Add and Delete Categories

Edit Objects Buttons 
Add, Delete, Edit, Get Info and 
Create New Objects

Coordinate System List
List of Geodetic and Projected 
coordinate systems
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Category Folders
The area on the left contains the folders of coordinate systems and subcategories for both recently used coordinate 
systems and performed searches. Coordinate systems are organized into two categories: Geodetic (unprojected, in 
latitude and longitude) and Projected. Right-click a folder to rename it or create a new subfolder in it.

Coordinate System List
The coordinate system list displays the name, horizontal datum, point style units, EPSG code and envelope of 
each coordinate system. Columns can be resized and sorted alphabetically or numerically. Geodetic and Projected 
coordinate system categories are sub-divided into world regions (continent/country/state or province) to ease 
selection. To set a coordinate system, click the desired folder on the left and click the desired coordinate system 
from the list on the right. Right-click a coordinate system to access a context menu to View Info, Copy Object, 
Rename Display Name or create New Object.

Search
All categories and subcategories can be searched by specific or all criteria. Geodetic coordinate systems can be 
searched by name, horizontal datum, point style units, envelope and EPSG code. In addition to the previous criteria, 
projected coordinate systems can be searched by geodetic, projection type and projection name. When searching 
for a coordinate system, the results are displayed in the coordinate system list. Note that the search is always relative 
to the folder selected category in the coordinate systems folder list. Choose the top level Coordinate Systems folder 
to search through all geodetic and projected coordinate systems.

Three subcategories contain specific information:

All: Displays all of the coordinate systems within that category.
Recent: Displays all of the recently used coordinate systems within that category.
Search History: Displays all of the search results for that category.

Notes:	 The subcategories All, Recent and Search cannot be searched. 
 
To clear the Recent and Search subcategories, right-click and choose Clear Recent (Search) History.

For a more information on projections and coordinate systems, as well as details on editing and adding 
to the coordinate system database and loading and importing a coordinate system file or database, see 
Chapter 4 -  Transformations and Coordinate Systems. Also see the Avenza Projections Guide.pdf installed with 
Geographic Imager.

IMPORTANT NOTES

Mac OS X only
When opening a geospatial PDF and a copy of it (i.e. saved as a different name) at the same time, the 
georeferencing will not be read on the image that is opened second. Referencing will have to be specified manually. 
This is due to a limitation in Adobe Photoshop.
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CHANNEL MANAGEMENT

Adobe Photoshop uses channels to store color information about an image. Geographic Imager Channel 
Management allows you to control channel mapping and assignment of channel color roles for false-composite 
multiband imagery. Channel Management is available on the Geographic Imager panel and in Advanced Import 
(see chapter 11).

Channel Management
Click the Channel Management button to 
open the Channel Management dialog box. 

The Color Mode drop-down list provides available color modes such as RGB Color, Lab Color, Grayscale, and CMYK 
Color. Each color mode has its own set of channel colors:

Color Mode Color Mode Channels

RGB Color Red, Green, Blue

Lab Color Lightness, A, B

Grayscale Gray

CMYK Color Cyan, Magenta, Yellow, Black

To edit how the color mode channels are assigned, click the Channel Role drop-down list to assign that channel 
a new color (such as Red, Green, or Blue, for an RGB color mode). To change a channel name, double-click one in 
the Channel Name column and type a new name. Enable the Live Preview option (Windows only) to see how the 
visibility and channel role adjustments affect the image. When these changes are confirmed, they are reflected in 
the Adobe Photoshop Channels panel.

Note:	 Live Preview is not available on Geographic Imager for Mac.
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Geographic Imager adds a new dimension to Adobe Photoshop 
by having the ability to transform georeferenced images into 
a common coordinate system. It also allows you to specify a 
custom coordinate system for transformation. Transforming 
spatial images into another coordinate system is an integral 
part of Geographic Imager.

Geographic Imager supports many coordinate systems from 
around the world.

This chapter provides information on how to transform a spatial 
image, select and apply a coordinate system, and load, edit and 
import a custom coordinate system.

Topics covered in this section:
Transform
The Geodetic Data Source

Transformations 

and Coordinate 

Systems



View coordinate 
system information
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The Transform feature reprojects an existing georeferenced image from its original coordinate system to another 
one. The transformed, or destination image, and associated reference file can be used in many GIS, CAD and 
desktop mapping systems including MAPublisher for Adobe Illustrator.

Transform
Click the Transform button to 
open the Transform dialog box. 

Destination Coordinate System 
Displays the current coordinate 

system. To change it, click the 
coordinate system desination 

hyperlink or choose From File or 
click Same As and choose from 

the drop-down menu. 

Datum Shift
If a datum shift is required, the 

Specify button will be enabled to 
choose an alternative datum shift

Pixel Size
The image pixel size in the 

destination coordinate system

Strip width
The amount of pixels in each strip of 
the raster image to be transformed

Resampling Method
Specify a resampling method to 

determine how destination
pixels are calculated

Transform 
Launch the
Transform process

Pixel Dimensions
If necessary, modify the 
current pixel dimensions

Precision
The precision affects how the 

strip widths are created

USING TRANSFORM

When an image has a coordinate system specified (see Chapter 3), the Transform button in the Geographic Imager 
panel will be enabled. Click the Transform button to open the Transform dialog box—which displays the current 
geographic parameters of an image and settings to transform it.

To set the coordinate system to be the same as that of another currently open and referenced image, choose the 
Same As option and the desired image from the drop-down list. If there are no other referenced images open this 
option will be disabled. Modifications to pixel size, resampling method, and strip width are available as options 
(explained in detail below).

To set a destination coordinate system, click the coordinate system hyperlink. The Specify Destination Coordinate 
System dialog box opens and displays coordinate systems and projections available in the Geographic Imager 
data source. This dialog box is similar to the one seen in Chapter 3, however, specifying a destination coordinate 
system instead of a source. Explore the categories to find and select the desired destination coordinate system. 
Alternatively, click the From File button to use an coordinate system definition from another file.

Transform

Trim transparent edges 
Removes excess  
transparency in the image 
when transformed

Layers
Option to leave layers 
intact, merge raster layers 
or merge layers
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Note:	 Coordinate systems are tested upon selection/transformation to verify its suitability for a referenced image. 
A warning will appear if the coordinate system appears to be partially or fully incompatible (based on the 
coordinate system envelope).

Geographic Imager automatically selects an appropriate datum shift for the transformation if required. If the 
selected datum shift is not the desired one, click the coordinate system hyperlink to open the Select Datum Shift 
dialog box. Datum shift types are displayed in the left category column titled Matching Datum Transformations.

Each category contains the associated datum shift(s) for that reference network. To view the information associated 
with the datum shift(s), click the View Datum Transformation button. If a second datum shift is necessary, reference 
networks will be listed in a subcategory called Using (coordinate system) as Intermediate Datum. The View Second 
Datum Transformation button will be enabled to view the secondary datum shift information.

Notes:	 Due to the complex nature of performing such transformations, this process may require extended 
processing time depending on the original image size, destination pixel size, strip width, resampling method 
and other parameters. For multiple transformations, consider running scripts or actions to automate tasks.

Multi-layer transformations can be transformed without flattening the image, maintaining the original layers. 
Existing transparency is properly maintained during transformation. To guarantee a seamless destination 
image (i.e. with no gaps between the adjacent layers), make sure there is a sufficient pixel overlap between 
the layers (e.g. when tiling the original image). Using Nearest-Neighbor method or a smaller strip width may 
also solve the problem.

Multi-spectral images are supported and maintained for transformations, including support for infrared 
(RGBI), alpha and spot channels.
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Note:	 Layer masks are ignored during the Transformation process. Layers masks are retained, however they may 
cause unforeseen errors if used in a workflow. It is recommended that layers masks be removed before any 
transformations are performed.

Caution:	 Upon saving an image after a transformation has been performed, Geographic Imager will update the 
reference file automatically and the original reference file will be overwritten. In order to keep your original 
image and reference files, you may choose to use the Save As command with a new file name and/or file 
location rather than using the Save command.

PIXEL OPTIONS

Pixel Size
The Pixel Size indicates the pixel resolution as the ground distance covered by each pixel of the image. The pixel 
dimension and unit (corresponding to the selected destination coordinate system) are displayed. Pixels are 
commonly square for projected coordinate systems. In a geodetic coordinate system, pixels are not necessarily 
square due to a varying size of degree of latitude depending on geographic location. Therefore, the x-to-y ratio of 
a pixel could be determined by the value of the Central Latitude which is commonly estimated by the center of the 
image. Click the Modify button in the Transformation dialog box to open the Modify Pixel Dimensions dialog box. The 
following are the available methods to calculate pixel dimensions:

•	 Preserve existing: Keeps the pixel dimension ratio the same as in the source image. It keeps the transformed 
geographic extents close to the original.

•	 By center of output image: Calculate the pixel ratio based on the central latitude of the outgoing image 
which will be the latitude of the true scale. Choose this option to minimize the distance of distortion.

•	 Keep pixels square: Ensures the pixels of the transformed image are square.

•	 User specified: Specify a custom x-to-y ratio. Enables Pixel Size text boxes above.

Note:	 Certain methods such as Preserve existing and By center of output image methods are not available for all 
transformations. To use the Preserve existing method, the transformation needs to be either Geodetic to 
Geodetic or Projected to Projected. If the destination image is geodetic, “y” pixel dimension is effectively 
determined by the choice of the central latitude (which is also the latitude of the true scale), therefore the 
option to set the pixel ration By center of output image is only available when the transformation outcome is 
indeed Geodetic.
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ADVANCED OPTIONS

Resampling Methods
When transforming an image, there are several options for resampling during transformation:

•	 Nearest Neighbor (preserve hard edges): Takes the value of the pixel that is closest to the transformed 
location in the source image. This is the fastest method in terms of processing time and is the method to use to 
preserve a colour panel during image transformation. It is also the best method to preserve original colours in 
some non-RGB colour modes, such as CMYK, by avoiding the internal conversion to/from RGB.

•	 Bilinear: Takes a weighted average value of the four pixels closest to the transformed location in the source 
image. This method results in a smoother image than the nearest neighbor method but at the expense of more 
processing time.

•	 Bicubic (best for smooth gradients): Takes a weighted average value of the sixteen pixels closest to the 
transformed location in the source image. 

Notes:	 A coordinate system transformation will resample an image, therefore any image analysis or classification 
should be performed prior to a transformation.

These resampling methods can also be changed through Adobe Photoshop General preferences.

Layers
•	 Leave intact: Maintains the original layer structure.

•	 Merge raster layers: Combines only raster layers while maintaining vector layers, for example text and 
transparency. Choose this option to guarantee seamless edges between different layers, especially if they don’t 
have overlapping margins.

Note:	 Shaded relief effects will be disappear after transformation is performed using "Merge raster layers".

•	 Merge layers: Combines all layers into one layer, maintaining transparency.



56 Geographic Imager User Guide
Transformations and Coordinate Systems

Precision and Strip width
To provide necessary transformation performance, Geographic Imager transforms one horizontal strip of the image at a 
time. Change the Precision to adjust the strip width being transformed:

•	 Maximum (very slow): Does not use strip widths and uses a special algorithm to perform transformation.

•	 High (slow): Uses a strip width of 10 pixels—high quality results and slightly slower transformation performance. 

•	 Normal: The default setting using a strip width of 50 pixels—a reasonable value for the majority of raster imagery 
combining good quality results and high transformation performance. 

•	 Medium (fast): Uses a strip width of 250 pixels—good quality results and faster transformation performance.

•	 Custom: Set a custom strip width.

Some images may be optimized by setting a custom strip width, which may be especially true when working with very 
small/world scale data, high latitude/polar area imagery or projections that introduce severe spatial distortions. If the 
result contains visible horizontal stripping artifacts or transparent gaps, choose a smaller strip width or the Maximum 
precision setting. Choosing a smaller strip width will result in a higher-precision transformation, but the transformation 
process may be slower. Alternatively, for low-deformation, large-scale data or for a quick preview of transformation 
results, a larger strip width can be used. 

For example, if an image being transformed displays a spherical curve, a smaller strip width may be necessary to 
maintain a smooth image edge. If a larger strip width is used there may a be a stepped edge to the image.

Trim transparent edges
Enabled by default, this option trims any excess transparency while maintaining the extents of the image.
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The Geodetic Data Source

Geographic Imager can support an unlimited number of custom linear and angular units, ellipsoids, datums, datum 
shifts and coordinate systems. The parameters for each definition are stored in geodata.xml and is referred to as 
the geodetic data source. It is a read-only file and is located in the following locations:

Windows: \Program Files\Avenza\Geographic Imager\Data Source Files
Mac OS X: /Applications/Avenza/Geographic Imager/Geographic Imager Plug-in/Data Source Files

Geographic Imager allows the creation of custom definitions where parameters are stored in a separate XML 
file that can be saved or loaded—named customsystems.xml by default. It is recommended to use the default 
name and default save location as Geographic Imager will have an option to keep a backup of these files when 
uninstalling (Windows only) or re-installing. The backup files are located in:

Windows XP: \Documents and Settings\All Users\Application Data\Avenza\Geographic Imager
Windows Vista/7: \ProgramData\Avenza\Geographic Imager
Mac OS X: /Applications/Avenza/Geographic Imager/Data Source Backup

Geographic Imager will also create a file called customview.xvw. This view file stores the organization and folder 
structure of your custom coordinate systems within the geodetic data source. This file will also be included in the 
above locations when uninstalling (Windows only) or re-installing. 

For Mac users, to restore the geodetic data source, copy the backup files from the backup folder to the appropriate 
locations. For Windows users, the custom geodetic data source is restored automatically if the option to backup files 
was chosen during the uninstall process.

LOAD CUSTOM COORDINATE SYSTEMS

A geodetic data source or coordinate system database can be loaded into Geographic Imager, greatly extending 
the coordinate systems available for use. In the Geographic Imager panel panel options menu, click Load Custom 
Coordinate Systems and browse for a geodetic data source.

When loading a custom coordinate system, remember that an accompanied schema file named geocalc.xsd must 
be present with the XML file. If not present, the geocalc.xsd file can be copied from the Data Source Files folder 
located in:

Windows XP: \Documents and Settings\All Users\Application Data\Avenza\Geographic Imager
Windows Vista/7: \Program Files\Avenza\Geographic Imager\Data Source Files
Mac OS X: /Applications/Avenza/Geographic Imager/Geographic Imager Plug-in/Data Source Files
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EDIT CUSTOM COORDINATE SYSTEMS

Geographic Imager can be extended to support custom coordinate systems. By editing the geodetic data source, it 
is possible to transform coordinates to and from a coordinate system that is based on a standard map projection but 
is not predefined within Geographic Imager. To edit a custom coordinate system, click Edit Custom Coordinate Systems in 
the Geographic Imager panel options menu.

At the top of the Edit Custom Coordinate Systems dialog box, two directory paths are listed: the geodetic data source 
path and the custom data path.

Note:	 The geodetic data source file is protected (read-only). Any additions or modifications to coordinate systems 
are stored in a separate XML file called customsystems.xml.

On the left-hand side of the dialog box is the data source object folders. To expand a folder to see its subfolders, 
click the plus sign (Windows) or arrow (Mac) to the left of the category name. To see the entries at any particular 
level of category, click the category itself. When an object, folder or subfolder is selected, the data source objects 
list box to the right displays the information stored within each one. User defined coordinate system objects can 
be organized using drag-and-drop between folders. Columns can be resized and sorted alphabetically/numerically.  
Right-click on a column header to show or hide it. Entries loaded from the main geodetic data source will be shown 
in black text, while entries from the custom data file will be shown in blue.

To create a new folder, click the New Folder button. A new folder will be titled "New Folder" by default and can be 
renamed. Subfolders can also be created using the same method. Only user-defined categories can be deleted 
using the Delete Folder button.

Edit Object Buttons 
New Object, Delete 
Object, Edit Object, 
View Info and Copy 
Object buttons

Data Source Objects List
Objects that belong to 
the selected data source 
object folder

Data Source Object Folders
Categories of objects 

that belong to the 
geodetic data source

New Folder / Delete Folder
Add or remove a data 

source object folder
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WORKING WITH DATA SOURCE OBJECTS

Individual entries in the geodetic data source are known as Data Source Objects. Geographic Imager can support an 
unlimited number of custom objects. There are different types of objects for different types of definition. Objects 
contained in the geodetic data source are:

•	 *All*: used to define the orientation of axes used and the type of units used in the system.

•	 Angular Units: type of units for measuring rotation.

•	 Coordinate Systems: a complete definition needed to express the context of a set of map data.

•	 Datum Transformations: parameters to transform coordinates from one datum to another.

•	 Ellipsoids: an ellipsoid gives a horizontal datum its size and shape. An ellipsoid does not have an origin and 
cannot be used as a base model for coordinates on its own.

•	 Envelopes: defines a geographic area of use for a particular object.

•	 Horizontal Datums: more commonly referred to as just "datum" is the base model maps are built on. All 
coordinate systems must have a datum associated with them to be related to any other map. Without a known 
datum, coordinates are meaningless.

•	 Linear Units: units for measuring straight line, Cartesian distances.

•	 Prime Meridians: defines longitude values of meridians.

CREATE NEW DATA SOURCE OBJECTS

In the Edit Custom Coordinate Systems dialog box, click the New Object button  to create a new data source 
object. When creating new data source objects, the identification information and definition parameters need to be 
completed. Complete this information in the respective Identification and Definition tabs.

The Identification tab is used to name the object and associate identification codes with it (if applicable). It is 
important to enter an appropriate name for the object. The Remarks field can be used to add notes on a definition 
and is optional. The Identifiers list may be used to add identifying codes for an object that may come from other 
databases. The GC code is a unique identifier assigned by Geographic Imager and should not be altered. To enter 
additional codes use the space below it.

The Definition tab is used to define the parameters of an object. Each object has parameters unique to it. Refer to the 
list below when creating new objects.

Note:	 Refer to the Avenza Projections Guide for more information on supported projections and their parameters 
as well as supported datum transformations methods.
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*All*
For coordinate points, specify the coordinate point dimensions in either 2D or 3D. For Geodetic and Projected 
Coordinate Points, the Longitude and Latitude style of units must be entered for all 2D Dimensional Points. The 
Longitude, Latitude and Ellipsoid Height style of units must be entered for 3D Dimensional Points.

            

Angular Units
For angular units, enter a conversion for the new unit in terms of the scientific standard Degrees. The Abbreviation is 
used to identify the unit within the application interface (Example: The abbreviation for degrees is "deg").
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Coordinate Systems
For Coordinate Systems, select an Envelope defining the appropriate area 
of use. If you are unsure of the appropriate envelope, you can leave it set to 
the default World envelope. The Point Style is how you will select the style of 
linear units for your system. For most projected systems, you will want to select 
"Projected point in (units)". Then select the Geodetic model that using the 
appropriate datum for your system. When you select the appropriate projection 
for your system, the parameters needed to define the system will appear in the 
table below. Enter the needed parameters and define the units each parameter 
is specified in.

   

Datum Transformations
For Datum Shifts, select an Envelope (appropriate geographic area of use), 
Source, Target and Method. If you are unsure of a more specific envelope, leave 
it set to the default "World" Envelope. The Source and Target fields are used 
to specify the two geodetic models the Transformation is valid for. The Method 
specifies the necessary parameters to define a particular datum transformation. 
With the proper method selected, enter the appropriate parameters for 
your datum transformation. Be sure to define the appropriate units for each 
parameter by clicking the Units button.

Ellipsoids
For Ellipsoids you must enter the parameters for the Semi-Major Axis and Semi-
Minor Axis (often noted as "a" and "b" respectively) define the linear units the 
axes are specified in by selecting a predefined unit in the appropriate fields. 
The Inverse Flattening (often noted as "1/f") will automatically calculate in 
the field below. Alternately, you can make the Inverse Flattening definitive by 
enabling the check box at the bottom. You can then manually enter the Inverse 
Flattening rather than the Semi-Minor Axis parameter.
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Envelopes
For Envelopes, specify the extents of the envelope (it is not required but 
recommended). If the Specify Extents Points check box is checked, it is required to 
enter the minimum and maximum points of the envelope and the point style the 
value represent.

Horizontal Datums
For Horizontal datums you must select the Ellipsoid the datum is based on, as well as 
the prime meridian used.

Linear Units
For Linear units, enter a conversion for the new unit in terms of the scientific 
standard Meters. The Abbreviation is used to identify the unit within the 
application interface (Example: The Abbreviation for Meters is "m")

Prime Meridians
For Prime Meridians you must enter the longitude value of the Prime Meridian 
and the angular unit that value is in.
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EDIT OBJECTS

To edit a custom or user-defined object, click the Edit Object button . Edits may be made in the respective object 
editor dialog box. Alternatively, double-click an object to open the editor dialog box. When a data source object 
belonging to the master data set is selected, the Edit Object button  is disabled (because these objects are read-
only). To modify an original object, create a copy of the object first then edit it.

DELETE OBJECTS

When a data source object belonging to the master data set is selected, the Delete Object button  is disabled. 
Only user-defined objects can be deleted.

COPY OBJECTS

Any object can be copied. To create a copy of an object, select an object and click the Copy Object button . A 
dialog box will appear with "Copy of:" preceding the object name in the Name box.

MOVE OBJECTS

Any user defined object can be moved. Drag-and-drop an object from the Data Source Objects List to a Data Source 
Object Folder. A dialog box will prompt you to move the object or to create a shortcut to it.

LOAD CUSTOM COORDINATE SYSTEM DEFINITIONS

In some instances, the coordinate system of an image is not listed in the geodetic data source or the reference file 
format does not support the coordinate system. In such cases, it may be useful to load custom coordinate system 
definitions. In the Geographic Imager panel options menu, click Load Custom Coordinate System. Geographic Imager can 
use the following coordinate system file formats: WKT definitions (.wkt), MapInfo MAP files (.map), MapInfo TAB files 
(.tab) and Esri projection files (.prj).

Notes:	 When a new coordinate system definition is loaded, it automatically replaces the source coordinate system 
of the currently selected image. To transform the image to the loaded coordinate system, open another 
referenced file and then load the coordinate system to that file. In the Transform dialog box, choose the Same 
As option to make the destination coordinate system identical to the image of the loaded coordinate system. 
 
When a coordinate system definition is loaded, it is added to the geodetic data source but not saved. If the 
loaded file matches an existing definition, the original definition will be used and the loaded definition will 
not be added. All new definitions are located at the top level of the appropriate category in the Coordinate 
Systems folder list (in either Geodetic or Projected). Before exiting Adobe Photoshop, be sure to save your 
geodetic data source if you wish to use the coordinate system definition again.
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Data providers and government agencies provide many types 
of rasters including orthophotos and DEM files, many of which 
are available without charge. Often, these rasters are tiled and 
must be merged to generate a single and seamless coverage 
area. The Geographic Imager Mosaic function mosaics 
adjoining images to create composite spatial images.

Topic covered in this section:
Mosaic Tool

Mosaic
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FUNCTIONALITY

The Mosaic function creates a single composite georeferenced image from multiple input georeferenced images, 
including DEM files. Available documents for the mosaic process may have different properties such as coordinate 
system, pixel size and rotation angle. These documents are transformed to match the properties of the destination 
document. Advanced transformation options may be used when performing a mosaic that requires a coordinate 
system transformation, resampling to match pixel size or rectify a rotation.

Note:	 Transformations during mosaic are not supported when the destination document contains a rotation angle 
or is in GCP mode. To mosaic into a destination document containing rotation the available documents to be 
mosaicked must have the same coordinate system, pixel size and rotation angle.

Mosaic Tool

Destination Document
Displays the document 
and coordinate system 

of where the mosaic will 
occur and be stored

Available Documents
Lists the images 

available for mosaic. 
Incompatibility notes 

shown when there is an 
issue with an image.

Advanced transformation 
options - Set resampling 

method, layer options, 
precision and strip width

Crop to current canvas 
Crop to the extents of the 
destination document

Select All
Select all available 

documents

Selected Documents
Lists the images 
selected for mosaic

Transfer buttons
Use buttons to move 
the images between 
Available and Selected 
Documents lists

Order buttons
Use Up and Down 
buttons to reorder the 
images. Image layer 
order is reflected in the 
destination image. 

Mosaic
Click the Mosaic button to 
open the Mosaic dialog box. 
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PREREQUISITES

A reference file must exist for each available input document to be mosaicked. The reference file is used to 
determine the spatial extents of both input and destination documents. Images that have no coordinate system 
specified can still be mosaicked, but they must have the same pixel size and rotation as the destination document. 
Mosaicking images that have different pixel size and rotation as the destination document may result in an 
incorrect mosaic.

If the destination document contains a rotation, the input images must also contain the same angle of rotation, 
coordinate system and pixel size to be able to perform a mosaic. Prior to mosaicking rotated images, it is 
recommended to flatten and duplicate each layer and delete the background layer (if one exists). This ensures that 
the mosaic will be seamless without any white spacing between the images.

If the destination document is in GCP mode, it should be switched to Standard mode through the Georeference 
dialog box.

USING MOSAIC

The first step to mosaic spatial images is to open all the georeferenced image files (at least two). Make sure the 
destination document (where the mosaic will occur) is the active document and click the Mosaic button in the 
Geographic Imager panel.

The Mosaic dialog box displays the destination document and destination coordinate system at the top. The 
Available Documents list displays all open documents that can be included in the mosaic. Images that do not satisfy 
the mosaic conditions (e.g. non-georeferenced image) of the destination document are displayed in grey and the 
reason why they are not available is stated. 

Images that meet the mosaic conditions of the destination document can be selected individually or by using the 
Select All button. At least two documents are needed to create a mosaic image (the destination document and 
at least one document in the Selected Documents list). To move selected available documents to the Selected 
Documents list, click the ">>" button. To remove a document from the Selected Documents list, click the “<<” 
button. All documents in the Selected Documents list will be used in the mosaic.

Documents can be reordered by using the Up and Down buttons. The document at the top of the Selected 
Documents list will be the first layer at the top of Adobe Photoshop Layers panel after the mosaic is created.

Use the Crop to current canvas option to crop to the extents of the destination document. Documents incompatible 
when this option is enabled are stated in the Available Documents list.

ADVANCED TRANSFORMATION OPTIONS

Enabled when a transformation during Mosaic is required. See the Advanced Options section in Chapter 4.
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RESULTS

After completing a mosaic, all images other than the current image of the destination document will have their 
layers grouped into image specific subfolders (the subfolder is named after the image file name). 

The mosaic can be treated like any other spatial image (e.g. toggle visibility, lock layers, adjust colours). Other 
Geographic Imager tools can be used on the mosaic such as Georeference, Transform, Tile and GeoCrop. However, 
some functions may merge the layers, while others will keep the mosaic layers intact.

IMPORTANT NOTES AND LIMITATIONS

Unsupported image colour modes for the destination document are Indexed Colour, Bitmap and Adobe Photoshop 
Multichannel. The mosaic colour mode will be the same as the colour mode of the destination document. 

Images with multiple channels will maintain its channels. Available documents with mixed alpha channel types 
(selected or masked) are merged with the alpha channel type of the destination document. Spot channels in the 
destination document are maintained, however, spot channels in available documents are discarded. 

It is recommend to perform any coordinate system transformations as early as possible during the image editing 
process to minimize potential adverse effect on a complex layer structure.

An image can not be mosaicked when it is in GCP mode. Change the image mode to Standard in the Georeference 
dialog box. See Chapter 8 - Georeference.

Shaded relief effects will be merged when a transformation is performed using the Merge raster layers option.

Several Adobe Photoshop limitations exist that relate to Mosaic:
•	 Layers masks may cause unforeseen errors if used. It is recommended that layers masks be removed before any 

mosaics are created.
•	 Images that are mosaicked or combined using the Adobe Photoshop Photomerge operation will not retain 

georeferencing information.
•	 It is recommended to convert to RGB colour mode first to preserve the channels in Adobe Photoshop 

multichannel images.

Image layer that forms 
part of the mosaic

Destination document layer
(not in a subfolder)

Layer group subfolder
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Tile

The tile process consists of converting large raster images into 
a series of smaller georeferenced images to make them more 
manageable. 

An image can be divided into a specific number of tiles or by a 
set of tiles of a fixed size.

Topic covered in this section:
Tile Tool



70 Geographic Imager User Guide
Tile

FUNCTIONALITY

The Tile function creates multiple images from a single image. Tile an image using either of two methods: 
by number of tiles or by size of tiles. If the original image is georeferenced, the multiple image files will be 
accompanied by a reference file (or an internally referenced format such as GeoTIFF, BigTIFF or TIFF). When all 
settings are set, click OK to specify a file name and folder destination for the tile images to be saved in.

PREREQUISITES

Any image, whether it is a spatial image or not, can be tiled using the Tile function. It is recommended that all images 
be flattened before tiling. If a multi-layered image is tiled without flattening first, it will result in each tile containing 
all of the layers from the original image. In some cases this may result in blank layers in one or more of the resultant 
tiles if all layers do not contain image content that covers all image pixels.

Notes:	 Any non-georeferenced images can be tiled; however, the output files will contain no georeferencing. 
 
Tiles cannot be created when an image is in GCP mode.

Tile Tool

By Size of Tiles
Split image by specified number 

of pixels or ground units of current 
coordinate system 

Overlap
Defines the amount of overlap each 

image contains from its adjoining 
images along the edges

Keep images open
When checked, it 
keeps tile document 
windows open after 
they are created

Total Files
Displays the total number of files to 

be created. Number based on  
settings chosen above.

Naming
Choose how the tile file names are 
patterned: sequential numbering, 

separate row/column numbers, 
left-top corner pixels or left-top 

corner coordinates

Reference File Format
The current reference file used 
will be selected. The output 
reference file can be changed 
by selecting the desired format.

Precision 
The number of decimal places 
added in the file name. Available 
when Naming is set to Top-Left 
Corner Ground Coordinates.

By Number of Tiles
Split image into equal-sized tiles 

based on numbers specified in 
horizontal and vertical fields

Tile
Click the Tile button to open 
the Tile dialog box. 
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USING TILE

With an open image, click the Tile button in the Geographic Imager panel to open the Tile dialog box. 

The Tile dialog box displays two options for creating tiled images. The options for creating tiled images are 
By Number of Tiles or By Size of Tiles.

By Number of Tiles
This creates a series of equally-sized georeferenced image tiles from the original image. Specify the number of 
horizontal and vertical tiles. The total number of tiles are displayed in the Destination frame. Using this option 
creates tiles that are divided evenly into the extent of the image. Notice the horizontal and vertical dimensions of 
each tile is shown in the read-only (blue shaded) boxes.

By Size of Tiles
There are two options for creating tiles by a specific size: by number of pixels or by ground units of the coordinate 
system of the current image. For instance, if an image is in a coordinate system using meters, then the ground units 
option would be meters. Specify the horizontal and vertical tile dimensions. The total number of tiles are displayed 
in the Destination frame. Creating tiles by size may create smaller edge tiles that vary in size.

Overlap
Specify the amount of overlap that each tile has with its adjoining tiles. The amount of overlap for each tile can be 
set to either the number of pixels, ground units, or by a percentage (of the tile). The amount of overlap may be the 
same for both horizontal and vertical directions or different in each direction. This option may be especially useful 
to guarantee gap-free mosaicking of individually transformed tiles.

Destination
Total Files displays the total number of tiled image files that will be created for the current tiling operation. This 
value is updated as the number or size of each tile changes. Check the Keep images open check box to keep the tiled 
images open after the tile process is completed. It is unchecked by default.

The Reference File Format drop-down list contains reference file formats that will be created with the image 
tiles. The supported reference file formats are: World files, Blue Marble Reference, MapInfo TAB, ER Mapper ERS, 
ER Mapper ECW, Geospatial PDF, GeoTIFF and NITF.  The GeoTIFF, Geospatial PDF, NITF and ER Mapper ECW formats 
stores spatial information within itself. All other reference file formats chosen in the drop-down list will be output 
accompanied by any image format supported by Adobe Photoshop.

Output tile files in 
TIFF format

Corresponding reference  
files for each tile image  

(.tab is MapInfo TAB file format)
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There are four naming conventions for tiled image files: Sequential Numbering, Separate Row/Column Numbers, 
Top - Left Corner Pixel Coordinates, and Top - Left Corner Ground Coordinates. To specify a file name and folder location 
to save the tiles, click OK in the Tile dialog box after all settings have been made. 

The Sequential Numbering option begins numbering at the first tile in the top-left corner of the image and 
continues left to right, numbering each tile starting with the number 1 (e.g. tile-image_1.tif, tile-image_2.tif, etc). 
Both reference files and TIFF files are suffixed with the sequential tile number.

Sequential numbering 
of tiled images

Corresponding reference  
files for each tile image  

(.tfw files represent World Files)

The Separate Row/Column Numbers option suffixes both row and column number of the position of each tile, 
beginning at the top-left corner and moving left to right. The row is the first number and the column is the second 
number. Both rows and columns start numbering at 1 (e.g. tile-image_1_1.tif, tile-image_1_2.tif, tile-image_2_1.tif, 
tile-image_2_2.tif, etc).

Row 1, column 1 tile image

Row 1, column 2 tile image

Row 2, column 1 tile image

Row 2, column 2 tile image

Corresponding reference  
files for each tile image  

(.tfw files represent World Files)

The Top - Left Corner Pixel Coordinates option suffixes the top-left pixel coordinate of each tile to the file name. In the 
four-tile example below, the pixel coordinates are shown for each file.

Top-left pixel coordinate of (0, 458)

Top-left pixel coordinate of (270, 458)

Top-left pixel coordinate of (0, 0)

Top-left pixel coordinate of (270, 0)

The Top - Left Ground Pixel Coordinates option suffixes the top-left ground coordinate of each tile to the file name. In 
the four-tile example below, the ground coordinates (in meters) are shown for each file.

Top-left ground coordinate 
of (2379.46, 1136855.45)

Top-left ground coordinate 
of (334102.25, 574115.30)
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IMPORTANT NOTES

When tiling an image whose resolution is greater than 72 dpi, ECW and NITF output files will result in 72 dpi. ECW 
and NITF formats do not support change in storing and restoring resolution values.
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The GeoCrop tool crops georeferenced images based on 
known geographic coordinates. The Advanced Import uses 
the features of GeoCrop to import large images without 
opening them fully.

The topic covered in this section:
GeoCrop Tool
Advanced Import

GeoCrop
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FUNCTIONALITY

The GeoCrop function crops georeferenced images based on defined crop areas. There are several ways to specify a 
crop area: manually, by pixel, geodetic or projected coordinates, by using another document, by using a coordinate 
system envelope, or by proximity. When crop parameters are specified, the preview image will update to show the 
preview crop area. Cropped imagery retains georeferencing.

GeoCrop Tool

Partial Pixel Options
Change the way that 
partial pixels are handled 
when cropping an image

Output Dimensions 
Displays the final image 

dimensions and raw 
file size based on the 

specified crop area 

Cursor Coordinates
Displays coordinates 

based on the position of 
the mouse cursor

Show/Hide  
Preview Image

Make visible or hide the 
preview image

Select All
Select the entire image 

for cropping
Clear All

Clear all crop areas and 
specified crop values

Show/Hide  
Control Points

Make visible or hide 
the geographic control 

points (enabled in  
GCP mode)

Coordinate Entry Boxes
Enter the top-left and 

bottom-right corner 
coordinates for the 

crop area

Unit Type
Choose from Pixel, 
Ground Unit, Projected or 
Geodetic unit type

Zoom
Displays the amount of 
zoom. Resize dialog to 
adjust zoom.

Crop to Another Document 
Use the extent of another open document 
to define the crop area (enabled when at 
least two images are open)

Crop to Coordinate
System Envelope
Crop to a chosen coordinate 
system envelope

Crop by Proximity
Specify a beginning base point 
and a proximity from that point 
to define a crop area

Crop Area
Outlined in a dashed red 
line. Area outside crop 
area is grayed out.

Coordinate Format
Geodetic values can be 
entered in Decimal De-
gree or Delimited Degree 
Minutes Seconds. 

Crop Range
The crop range or 
coordinate extents of the 
image of each corner

GeoCrop
Click the GeoCrop button to 
open the GeoCrop dialog box. 
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PREREQUISITES

Any image can be cropped using GeoCrop. However, only georeferenced imagery will enable certain options in the 
GeoCrop dialog box. Images without georeferencing can only be cropped manually or by specifying pixel values.

To use the Crop to Coordinate System Envelope option, the current image must contain georeferencing.

To use the Crop to Another Document option, at least one other georeferenced document must be open.

To use the Show/Hide Control Points feature, the image must be in GCP mode.

USING GEOCROP

With an opened image, click the GeoCrop button in the Geographic Imager panel to open the GeoCrop dialog box. 
To GeoCrop the image, use the following options:

Manual Crop
Manual GeoCrop is the quickest and simplest method to crop an image. In the preview image, click and drag to 
draw a crop area. When a crop area is successfully created, a dashed red border frames it. The area outside of the 
crop area is shaded in gray. Use the cursor coordinates below the preview image to more accurately crop an image. 
The crop area can be only as large as the extent of the image and only one crop area can be defined at a time.

Crop By Pixel or Coordinate
Specify Pixel, Ground Unit, Geodetic or Projected in the Unit Type drop-down list to define a precise area. If an 
image is unreferenced, only Pixel can be specified for cropping unit (the Unit type drop-down list is disabled). 
When Pixel unit type is chosen, the crop area is measured in actual pixel values from the image. In the case 
that a reference file exists but no coordinate system is specified, Ground Unit can be chosen from the Unit Type 
drop-down list. GeoCrop coordinates are dimensionless but correspond to the same unit as the reference file 
(e.g. meters, feet, decimal degrees, etc). Specify both the top-left and bottom-right corner X and Y values in the 
coordinate entry boxes to define the crop area.

The Geodetic Unit type can be chosen from the Unit type drop-down list when an image is specified to a geodetic 
or projected coordinate system. Pixel and Geodetic are the only unit type options when the coordinate system 
is geodetic. In the Coordinate Format drop-down list, choose from two options: Decimal Degrees or Delimited 
Degrees Minutes Seconds (DMS). In the Lat/Long boxes below the drop-down list, specify both the top-left and 
bottom-right corner Lat/Long values (in either decimal degrees or DMS) in the coordinate entry boxes to define the 
crop area. The preview image reflects the values entered to draw the crop area.

The Projected unit type can be chosen from the Unit Type drop-down list when an image is in a projected 
coordinate system. The units specified will be the same as the current coordinate system of the selected image 
(meters, feet, etc). Also note that the Pixel and Geodetic unit types can be chosen from the Unit Type drop-down list 
when an image is in a projected coordinate system. Switching unit types when a crop area has already been defined 
will automatically convert the values to the new selected unit in the coordinate entry boxes.



78 Geographic Imager User Guide
GeoCrop

Crop to Another Document
This feature uses the spatial extent of another open document to define the crop area in the current document. 
In the Crop to Another Document dialog box, choose an open document from the Same As drop-down list. The 
preview image updates and draws the crop area using the extents of the document specified. It is important to 
use a document that falls within the extents of the current document. If only a portion of it falls within the image 
extents, it will still be cropped. If an open document is outside of the current document’s extents, it will fail to crop 
and a warning will appear.

Crop to Coordinate System Envelope
This feature uses the envelope of a coordinate system to define the crop area in the current document. Click the 
Crop to Coordinate System Envelope button to choose a coordinate system. The preview image updates and draws 
the crop area using the extents of the coordinate system envelope specified. It is important to use a coordinate 
system envelope that falls within the extents of the current document. If only a portion of the envelope falls within 
the extents, it will still be cropped. If a coordinate system envelope is outside of the current document’s extents, it 
will fail to crop and a warning will appear.

Note:	 To maintain a high-precision transformation, choose an appropriate coordinate system envelope. There may 
be instances where by choosing a coordinate system envelope that no datum shift exists. This may cause 
imprecise results. A warning appears if this should ever happen.

Crop by Proximity
Use this feature to crop an image based on proximity from a specific base point. Begin by setting the unit type 
(pixel, ground unit, geodetic or projected) and if necessary, the coordinate format (only for geodetic coordinate 
systems). Choosing a unit type changes both base point and proximity units.

In the Base Point frame, specify the X and Y values (or Lat/Long if geodetic) of the point of which the proximity will 
be based on. In the Use As drop-down list, choose a position for the base point. This position defines where the crop 
area is created relative to the base point. The diagram below explains base point positioning.

Point represents base point position. 
Square represents crop area.

top-left

center

bottom-left bottom-right

top-rightx

x

y

y
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In the Proximity frame, specify x and y values (in the same units as the base point) of which the crop area 
dimensions will be drawn to. If needed, check the Use same value for both dimensions check box to create a square 
proximity. If the unit type is Projected, it is possible to change the proximity units. Click the Change Units button 
and choose a new measurement unit. Accept the settings and the preview image updates and draws the crop area 
using the base point and proximity specified.

CROP IMAGE OUTPUT

Below the preview image, the output dimensions and raw file size of the crop area are listed. These values change 
as the crop area dimensions change. 

Pixel Round Options
When using a unit type other than Pixel, the coordinate values will not correspond exactly to a round pixel value, 
hence creating partial pixels. Partial pixels are created when a geodetic or projected coordinate falls between a 
range of pixels. Users may choose to keep these partial pixels, however they may make the image unreadable other 
software packages.

Decide how the output image pixels are handled with one of these options:
•	 Round to closest: partial pixel values rounded to the closest pixel
•	 Always use: keeps partial pixels and uses it in the output image
•	 Discard: drops partial pixels from the final output image

An image cropped with layers (e.g. mosaic image) will maintain its layers structure and alpha channels.
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The flexibility of the Georeferencing tool empowers 
Geographic Imager to provide an intuitive method for 
selecting reference points within a source image along with 
providing support for multi-layered images. Add ground 
control points (GCP) and georeference image files using affine 
or polynomial methods. 

This section provides an overview of how to establish ground 
control points and to georeference spatial images that do not 
have a reference file.

Topics covered in this section:
Georeference Tool
Coordinate System and Input Format
Quick Georeference
Import and Export Control Points
Georeference Preferences

Georeference
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Georeference Tool

Add Control Point
Add points to the 

reference list

Import Additional  
Control Points
Import a set of previously 
defined reference points

Export Control 
Points
Export the reference 
list to a  .log or .csv

Remove Georeference
Remove all georeferencing, 
including reference points 
and image coordinate system

Georeference Preferences
Set table precision, error 
detection tolerance, and 
coordinate format

Quick Georeference
Quickly georeference an 
image using one tie-point, 
two tie-points or by an 
existing document

Add Point
Click within the image 

view to add a new 
ground control point. 

Also adds a record to the 
Reference Point List

Cursor Coordinates
Displays pixel and image 

coordinates based on 
the position of the 

mouse cursor. When 
a DEM is open, also 
displays elevation.

Number of GCPs
Displays used and total 

number of points for 
georeferencing 

Mode
Georeferencing mode: 

Standard or GCP
Format

Displays image and 
input coordinates and 

input format

Select Points
Draw a marquee within 

the image view to 
 select available ground 

control points

Hand Tool
Pan to an area of 
interest within the 
image view

Zoom In / Zoom Out
Zoom in or out one level. 
Draw marquee to zoom 
in to a specific area.

Zoom To Extents
Zooms out and fits the 
entire image’s extents 
within the image view

Overview 
The overview of the image view. 
Toggle with Show/Hide Overview. 
Hold Ctrl and click to move it.

Method
Type of calculation 
used to compute 
georeferencing

Image View
Displays the source image 

and reference points

Ground Control Point
Location and name of 
ground control point

Image Size and Zoom
Image size and zoom 
percentage

Use
Point selection for use

Reference Point List
Table lists the following 
for reference points:

WY
Real world coordinate 
value for Y (North/South)

WX
Real world coordinate 
value for X (East/West)

PXY Error, PX Error, 
PY Error, WXY Error, 
WX Error, WY Error
Calculated error values 
between page (pixel) 
coordinates and real 
world coordinates

Forward and Inverse 
Residual Error
Total error of PXY and 
WXY of the used GCPs

Delete Selected 
Control Points

Delete selected points 
from the reference list

Name
Name for each point 

PX
Image (pixel)  
coordinate for X value
PY
Image (pixel)  
coordinate for Y value

Georeference
Click the Georeference button to open the 
Georeference dialog box. 
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FUNCTIONALITY

The Georeference function provides tools to georeference an unreferenced image by establishing reference or 
ground control points (GCP) and setting the source coordinate system. It can also be used to edit the existing 
referencing information of an image and be used to display and examine precise pixel coordinates, projected or 
geodetic, and point elevations (for DEM images).

Ground control points are a set of points in the image for which the real-world coordinates are known. The 
Georeference function links pixel coordinates to their corresponding real-world coordinates. World coordinates can 
be entered using several input coordinate format (e.g. in latitude/longitude for a projected image).

A referencing solution is calculated when GCPs are added, modified, or deleted, provided there are a sufficient 
number of included points for the solution model being used and that the image coordinate system is specified. 
Associated errors (the difference between computed values and the values specified) are displayed for each point 
in the reference point list. If required, modify reference points in order to minimize the referencing error and to 
prepare the image for subsequent transformation.

PREREQUISITES

Any image can be georeferenced using the Georeference function. To edit the existing referencing of an image, the 
georeferencing mode must be changed to GCP mode. Similarly, reference points can be added, modified or deleted 
only in GCP mode.

Notes:	 It is recommended that users do not edit reference points in Standard mode.  If reference points need to be 
edited, the mode should be switched to GCP to ensure the image is not distorted or rotated unexpectedly 
 
By not adding enough reference points to an unreferenced image, a warning will appear asking to switch to 
Standard mode. Standard mode maintains mathematical transformation rather than the explicit list of points.

USING GEOREFERENCE

With an opened image, click the Georeference button in the Geographic Imager panel to open the Georeferencing 
dialog box. The image view shows the current image and any ground control or reference points specified. These 
points and their pertaining coordinate and error values are shown in the reference point list.

If the coordinate system of an image is not recognized automatically (e.g. incorrect image format or no reference 
information), the image coordinate system and the control points input coordinate system must first be specified 
by clicking one of the links in the Format frame. The Input Format dialog box is described in next section.

In the Method drop-down list, select the georeferencing method that applies. The selected method determines the 
minimum number of control points required for georeferencing. See Appendix A for more information regarding the 
affine and polynomial solution models.
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There are two main methods to add reference points to an image: 1) add reference points in the image view 
manually; and 2) specify reference point pixel coordinate values in the reference point list. In addition, Quick 
Georeference methods are available. The latter methods are described in further detail in this chapter.

Add a Reference Point Using Image View
In GCP mode, click the Add Point button  above the image view. When the Add Point tool is enabled, the cursor 
in the image view becomes a cross hair. Pixel and coordinate locations can be viewed using the cursor location 
status along the bottom of the image view. Click within the extents of the current image to add a reference point. 
Points are added to the reference point list below the image view and are automatically assigned a name and pixel 
coordinates (PX and PY).

For each reference point, enter the corresponding real-world coordinates (WX and WY) in the reference point list. 
Real-world coordinates can be found from several sources: information displayed on the image itself, such as grids 
or graticules, or from external sources (e.g. survey, corresponding maps, etc). If enough control points are already 
present for the image (the number of points required depends on the selected method), real-world coordinates 
boxes are populated with estimated values calculated from the other points. These values should be edited for 
accurate referencing.

Add a Reference Point Using the Reference Point List

Alternatively, click the Add Control Point button  above the reference point list to add a new reference point to 
the list. This method locates a new point in the northwest corner (0,0) of the image by default. Once a point has 
been added, assign pixel coordinates and real world coordinates to the reference point by entering values in the 
respective PX, PY and WX, WY boxes. Points pixel values that are modified in the reference list changes are reflected 
in the image view. Right-click a row in the reference point list to access a context menu to delete, disable, center or 
zoom to a reference point.

Edit a Reference Point
Significant features on the image that are the base for control points are usually not represented on a single pixel. 
When manually adding points (on the image or typing pixel or world coordinates), some user error can occur and 
may result in large error values for the points. Moving control points by several pixels can greatly improve the error 
statistics to fine tune the georeferencing.
Points can be selected to be modified from the reference point list or directly in the image. Moving reference points 
on the image or changing the PX and PY values in the reference point list updates the pixel positions but not the 
entered real-world coordinates.

To select points on the image, click the Select Points button  and click a point or draw a marquee around 
multiple reference points. Another way to select tools in the image view is to access the context menu. Right-click 
anywhere within the image view to see available options. 

Remove a Reference Point
In the reference point list, click a reference point row to highlight it (alternatively, choose multiple rows). Click the 

Delete Selected Control Points button  to delete the point(s).

Find Elevation Value of a DEM/DTM
To find the elevation value of a DEM or DTM, it must be imported using a DEM schema. In the Georeference dialog 
box, the actual elevation value is displayed below the image preview. Move the mouse cursor to any position within 
the image view to see the values (updated in real time). Note that after applying Terrain Shader, the elevation value 
will not be available.
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Image Coordinate System
Click the coordinate system hyperlink to choose an image coordinate system.

Input Coordinate System
Check the Use alternate input coordinate system option and specify the coordinate system of the ground control 
points. When this option is unchecked, real-world coordinates of GCPs are based on the coordinate system of the 
current image.

Coordinate Format
The input coordinate system and the input format represents how the input point coordinates are entered into the 
reference point list. When the input coordinate system of GCPs is projected, the WX and WY coordinates are entered 
in the units of the coordinate system (e.g. meter, kilometer, feet). When the input coordinate system of GCPs is 
Geodetic, the Lat/Long coordinates (WX/WY) are entered in degrees. In this case, the values entered into the WX 
and WY text boxes can be in different formats. Select one from the Coordinate Format drop-down list:

•	 Decimal degrees (D+[.d*])
•	 Delimited Degrees Minutes Seconds (D+ MM SS[.s*])
•	 Degrees.Minutes (D+.MM[m*])
•	 Degrees.MinutesSeconds (D+.MMSS[s*])
•	 Packed DMS with decimal point((D)DDMMSS[.s*])
•	 Packed DMS ((D)DDMMSS[s*])

Note:	 Items in [ ] are optional, * means zero or more digits, + means one or more digits.

The Format frame in the Georeference dialog box contains information about the image coordinate system, GCP 
input coordinate system and the input coordinates format. The Image Coordinate System represents the coordinate 
system of the current image, the Input Coordinate System represents the coordinate system of the control point’s 
real-world coordinates. To change any of these settings, click any of the format links underlined in blue to open the 
Input Format dialog box.

Coordinate System and Input Format

Image Coordinate System
The current coordinate system

Use alternate input 
coordinate system

Check to use an alternate 
input coordinate system

Alternate Input  
Coordinate System
Specify the reference coordinate 
system in which the point 
coordinates are entered. 
Choose Same as to match an 
input coordinate system of 
another document.

Input Coordinate Format
Select the coordinate format 

that the WX and WY should be 
entered as

Display Decimal Precision
Set the geodetic and 

projected decimal precision. 
The precision is saved on 

confirmation.
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Degrees coordinate format examples:

Formats Decimals 
Degrees

Delimited 
Degrees Minutes 
Seconds

Degrees.Minutes Degrees.MinutesSeconds Packed DMS with 
decimal point

Packed DMS

Lat 43.6969N 43d41’48.98”N 43.418163N 43.414898N 434148.98N 43414898N

Long 79.3922W 79d23’32.38”W 79.235396W 79.233238W 0792332.38W 079233238W

Lat 43.6969 43 41 48.98 N43.418163 N 43.414898 434148.98 N 43414898

Long -79.3922 W 079 23 32.38 W79.235396 W 79.233238 -0792332.38 W 079233238

Lat N 43.6969 N 43-41-48.98 43.418163 43.414898 N 434148.98 43414898N

Long -079.3922 W 79:23:32.38 -079.235396 -079.233238 W 0792332.38 -079233238

Lines of latitude run East-West (e.g. the Equator), whereas lines of longitude run North-South (e.g. Greenwich 
Meridian). Positive degree values represent north latitudes and east longitudes. Negative degree values represent 
south latitudes and west longitudes. Directions can be entered either with positing/negative values or using the 
letters N, S, E or W preceding or following the numerical values, separated or not with a space.

Valid delimiters for Delimited Degrees Minutes Seconds format are: 
•	 space, hyphen (-), colons (:) or underscore (_) : e.g. 43 41 48.98N, 43-41-48.98N, 43:41:48.98N or 43_41_48.98N
•	 d (degree), single quote (minute), double quote (second): e.g. 43d41’48.98"N 

Packed formats require the use of two digits for degrees of latitude (e.g. 1°N must be written 01) and 3 digits for 
degrees of longitude (e.g. 1°E must be written 001).

Decimal Precision
To modify the geodetic and projected decimal precision, change the settings at the bottom of the Input Format 
dialog box. Each coordinate format has its own default minimum and maximum decimal precision. The maximum 
decimal precision is 10 and the lowest is zero. The reference point list will be updated to reflect this precision when 
it is confirmed. These precision values are saved when the dialog box is closed.
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An image can be georeferenced using one reference point and the pixel or image size, two reference points, copy 
from an existing document or copy from a file. Certain conditions and information are needed using this approach.

To start, click the Quick Georeference button  in the Georeferencing dialog box. Choose one of the four Quick 
Georeference options:

•	 By Two Reference Points (North/South aligned)
•	 By Tie Point (North/South aligned)
•	 Copy From Document (same size/reference)
•	 Copy From File (same size/reference)

BY TWO REFERENCE POINTS (NORTH/SOUTH ALIGNED)

Requirements to use two points:
1.	 Two reference point coordinates are known, however these points must not contain the same coordinates in 

either the pixel (X/Y) or world (WX/WY) values.

2.	 The image is not rotated (image is North/South aligned).

Using this method changes the mode back to Standard. In this process, the four corner coordinates of the image are 
generated to define the referencing. Points that were not chosen to be used in the georeferencing are discarded. 
No dialog box opens for this method, the changes are implemented immediately.

BY TIE POINT (NORTH/SOUTH ALIGNED)

Requirements to use one tie point:
1.	 One reference point coordinate is known (pixel and world location).

2.	 The image is not rotated (image is North/South aligned).

3.	 The pixel size or image size in world units is known.

Pixel size or image size must be in world units (geodetic or projected). Change the method to enter either pixel size 
or image size.

Quick georeference by one tie point and existing document uses a georeferenced image as the source to 
georeference an unreferenced image (as long as the second condition above is met). An existing document must 
have the same coordinate system and pixel size but does not have to contain the geographic extents of the image 
being georeferenced. Select By tie point and existing document from the drop-down list to use this method.

Quick Georeference
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COPY FROM DOCUMENT (SAME SIZE/REFERENCE)

This method copies all the geographic details from a georeferenced image into an unreferenced image. An open 
georeferenced document must contain the same geographic details as the image being georeferenced:

•	 Geographic extents (top left and bottom right corner coordinates)
•	 Image size
•	 Pixel size
•	 Rotation

Note:	 When Quick Georeference is used, the precision needs to be set to the longest pixel value. When the 
precision is less than the pixel value, the pixel value may be modified. When it is modified, the image will not 
be able to be mosaicked with other images of the same pixel value. 

COPY FROM FILE (SAME SIZE/REFERENCE)

This method copies all details from a georeferenced image to the current image. This is similar to the Copy From 
Document method, except that the source document does not have to be opened in Adobe Photoshop. Choose 
a supported file format and appropriate reference file to use for georeferencing and click Open to load its control 
points and coordinate system information.
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IMPORT PREVIOUSLY DEFINED REFERENCE POINTS

To import a set of previously defined reference points, click the Import Additional Control Points button  in the 
Georeference dialog box. Supported reference point file formats include Blue Marble Reference files (.rsf ), MapInfo 
Tab files (.tab), Comma Delimited files (.csv) and more. If the reference point list already includes several points, any 
imported points will be added to the existing list.

Provided that the required values are present, a .csv reference file can be created by adhering to the following 
syntax or by exporting from a spreadsheet application such as Microsoft Excel:

•	 .csv format: pixel X value, pixel Y value, ground X value, ground Y value
•	 .txt format: pixel X value [TAB] pixel Y value [TAB] ground X value [TAB] ground Y value

Notes:	 Importing a file with mixed delimiter formats is not supported. 
 
Log file format cannot be imported.

EXPORT POINTS

When in GCP mode, the current reference points can be exported to an external file for future use. Click the Export 

Control Points button  and save the points using the available export reference formats: log files (.log) and comma 
delimited (.csv).

The exported log file will contain all of the reference point pixel and world coordinates (including used and unused 
points), referencing method, residual error values, and points used. The exported comma delimited file will only 
include reference point pixel and world coordinates, but no residual error values or point names (including used 
and unused points).

Import and Export Control Points
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Click the Preferences button  to access the Georeference Preferences options.

Error Detection Tolerance  
Sets the range of error tolerance. 

A higher value means more 
tolerance, a lower value means 

less tolerance.

Control Point Color
Sets the reference point 

colors in the image view of the 
Georeference dialog box

ERROR DETECTION TOLERANCE

The standard deviation is calculated from the residual errors of the reference points. It is a statistic that indicates 
how much the input control points match with the computed values (depending on the chosen calculation 
method). In the Georeference Preferences dialog box, the Error Detection Tolerance is the product of the multiplier 
coefficient and the standard deviation.

Depending on the accuracy of the GCP points, the multiplier coefficient and the calculation method used, points 
that fall outside of the standard deviation range are considered as error. To set the threshold to tolerate more 
error, change the multiplier coefficient to a larger value. To set a threshold that will tolerate less error, change the 
multiplier coefficient to a smaller value. Points that do not comply with the tolerance range (standard deviation 
multiplied by coefficient) will be shown in red.

This method of error detection can be turned off by selecting None in the multiplier drop-down list. This will ensure 
all the reference points are listed in black.

Note:	 The values displayed in the Error Detection Tolerance correspond to the PXY error and the WXY error 
respectively. As the tolerance level is changed these values will update indicating the maximum tolerance 
value allowed. Values that exceed the maximum tolerance will be displayed in red in the list of GCP points.

Georeference Preferences
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Assessing Residual Errors
When enough points to compute a georeferencing solution are added, residual errors for each reference point are 
calculated. A residual error is the computed difference between an observed source coordinate and a calculated 
source coordinate. It is the measure of the fit between the true locations and the transformed locations of the output 
control points. A high residual error indicates possible error in either the observed source coordinates or the reference 
coordinates of the reference point in question. When the error is particularly large, you may want to remove and add 
control points to adjust the error. As a general rule, apply several different transformation methods, select/deselect 
questionable points and select the method and reference points that yield the minimum residual error, assuming that 
the defined reference points are correct.

Residual values are calculated via the associated error values between computed values and entered values 
through either the affine or various polynomial methods. 

See Appendix A for more information regarding the affine and polynomial solution models.

CONTROL POINT COLOR

Select colours for the point label and reference points that are in the image view of the Georeferencing dialog box.
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Geographic Imager supports the import of DEM files 
and has several options to render them. This chapter 
provides information on how to create and use DEM 
schema.

Topic covered in this section:
Import DEM File

DEM Schema 
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Import DEM File

FUNCTIONALITY

The Import DEM file dialog box provides options to apply a schema based on the statistics of the raster data set. 
Use a custom DEM schema, an auto-stretched schema or a raw data schema. A DEM schema increases the visual 
contrast of the raster display. Depending on the required appearance of the DEM, apply a schema suitable for 
the range of data within it. For example, DEMs may not contain the entire range of values that can be displayed; 
therefore, applying an appropriate schema may result in a sharper image and certain physical features may become 
easier to see. Each schema has its own advantages and disadvantages and is further discussed in this chapter.

PREREQUISITES

The image must be a supported form of elevation or terrain data to invoke the Import DEM file dialog box:

•	 ArcInfo ASCII Grid
•	 ArcInfo Binary Grid
•	 ArcInfo Binary Floating Grid
•	 BIL
•	 ERDAS IMAGINE

•	 Military Elevation Data / DTED
•	 USGS ASCII DEM / CDED
•	 USGS SDTS
•	 SRTM

Notes:	 See Chapter 2 for more information about supported DEM formats. 
 
BIL files may be opened as a raster. See Important Notes at the end of this chapter.

Select Schema
Choose from a list of 

available DEM schema 

Schema explanation
Brief description about 

the chosen schema

DEM unit and Precision
The units and precision 
of the selected schema

Advanced
Access Advanced DEM 
Schema Settings

Type 
Choose from:
DEM - Elevation data 
DTM - Terrain data
or <Auto detect>

Don’t show again 
Prevent this dialog box 
from appearing next time

Create Schema
Create a new DEM 
schema

Remove Schema
Delete a DEM schema

Edit Schema
Access the Edit DEM 
Schema dialog box

Digital Elevation Models (DEM) and Digital Terrain Models (DTM) provide an effective method of storing information 
for continuous surfaces. Measured elevation values of the earth’s surface is the most common application of DEMs, 
however, other applications include measurable phenomena such as rainfall, temperature and density. DEM data 
needs to be rendered so it can be displayed visually. Depending on what type of DEM data it is and how it should 
look, the type of rendering schema needs to be customized or automatically assigned.
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ASSIGN A DEM SCHEMA

When a supported DEM is opened, the Import DEM file dialog box appears. To prevent it from appearing every time, 
click the Don’t show again check box. To see the dialog box again after it has been checked, access the Geographic 
Imager Preferences and click the Reset All Warning Dialogs button.

In the Select Schema drop-down list, several schema are available and are discussed below. To assign a DEM 
schema, click the OK button to accept the settings of the Import DEM file dialog box.

Auto-stretched
The Auto-stretched schema displays continuous raster cell values across a gradual ramp of 
Adobe Photoshop grayscale colour space. This schema displays a single band of continuous 
data and works well when a large range of values need to be displayed. Auto-stretched 
allows for the best precision preservation and automatically generates high-contrast images.

Note:	 Using the auto-stretch schema may result in images that may not be compatible with 
other DEM files or may not be easily mosaicked.

Raw Data
The Raw Data schema assigns elevation data directly to the Adobe Photoshop grayscale 
colour space. The Raw Data schema facilitates mosaicking with other raw imported images. 
Since it does not produce a high-contrast image, use Adobe Photoshop adjustment tools 
such as Levels and Curves. Use the image preview in the Georeference Tool to see the 
original elevation data values. More information on this in the Important Notes section at the 
end of this chapter. Negative elevation values are stored on a separate layer.

Predefined Continental Schema
World, Antarctica, Asia, Africa, Australia, Europe, North America and South America are 
predefined continental DEM schema. These schema use common data ranges that allow 
for importing multiple files using the same schema, increasing compatibility and mosaic 
capability. These may be helpful in situations where a general schema is needed instead of 
several different ones. Since these schema are predefined, they cannot be edited or deleted.

Custom Schema
Custom schema are designated by blue text (or in its own list group on a Mac) in the Select 
Schema drop-down list. When a custom schema is chosen, the Remove Schema and Edit 
Schema buttons are enabled.

DEM units and Precision
The default DEM units are displayed during import. To change the default units, create or edit a DEM schema and 
click the Change Schema Units button . The precision of the DEM is displayed but cannot be edited.
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The Edit DEM Schema is populated with information available from the DEM. Any of the boxes can be edited to 
customize the schema.

The Lowest Elevation and Highest Elevation values represent the lowest and highest data values to be mapped in 
the Adobe Photoshop grayscale colour space. Editing these values will change how the image is displayed. The File 
Data Range shows the lowest and highest data values in the current DEM. Use it as a guide when entering custom 
elevation values.

The Restore Default Data Range button is only enabled when either the Lowest Elevation or Highest Elevation box 
have a custom value entered. Click the button to restore the data range as specified in the File Data Range display.

Vertical units is only used for mosaicking. The meter unit is displayed by default, which is not dependent on the 
reference file of the current document. To change the Vertical Unit, click the Change Schema Units button  and 
choose a new unit in the Select a unit for the DEM file dialog box.

DELETE A DEM SCHEMA

To remove a DEM schema from the Select Schema drop-down list, click the Remove Schema button .

EDIT A DEM SCHEMA

To edit a DEM schema, click the Edit Schema button . Geographic Imager analyzes the DEM to be edited and 
opens the Edit DEM Schema dialog box.

CREATE A DEM SCHEMA

To create a DEM schema, click the Create Schema button . Geographic Imager analyzes the DEM to be imported 
and opens the Edit DEM Schema dialog box.

Schema Name
The name of the schema 

as seen in the Select 
Schema drop-down list

Lowest Elevation
Specify the lowest data 
value to be used in the 

DEM schema

Highest Elevation
Specify the highest data 

value to be used in the 
DEM schema

File Data Range
Displays the lowest and 
highest data values 
found in the DEM

Restore Default Data 
Range Values
Restore input data range 
values to the Lowest 
Elevation and Highest 
Elevation boxes.

Vertical Unit
Used for mosaicking 
only. Default unit is 
Meter. Click the Change 
Schema Units button to 
change units.
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ADVANCED DEM SCHEMA SETTINGS

Advanced DEM schema settings must be used in conjunction with a custom schema. To access the advanced DEM 
schema settings, click the Advanced button in the Import DEM file dialog box.

Pixel Display Option
Choose from

Display as transparent pixels or 
Display as background pixels

Raw data: negative values 
as layer - Only for raw data 

schema type. Allows negative  
values to be exported to a 

separate layer.

Add New Value
Add new values to the 

unique values list

Remove Selected Value(s)
Remove selected value(s) 

from the unique values list

Unique Values List
Displays the values based on 
the Pixel Display option and 
the unit measurement of the 
current DEM

DEM elevation range
Always scan the dataset when it 
is loaded.  Use the signed data 
range included with the dataset.

These advances schema settings affect how specific values in the DEM are displayed. In the Pixel Display drop-down 
list, choose from one of the following:

Display as transparent pixels
For DEM files where a No Data value can not be detected, specify any value to be displayed as transparent. The 
unique values list displays any data values specified to be a transparent pixel. The pixels are not removed or deleted 
from the DEM when specified as transparent. A No Data value (-32767.00) is always displayed as transparency and 
can not be removed from this list.

Display as background pixels
This option displays any data values in the list as background pixels. Background pixels are generally used for the 
unique elevation values such as ground or water levels. Data values that are specified as background pixels are 
represented as a separate coloured layer called "Background" in the Adobe Photoshop layers list. Values on this 
layer are displayed as gradient pixels starting from 0 and increase in 1000 for each value specified.

Add and Remove values
Click the Add New Value button to add a new value to the list (range values are not supported). Double-click the 
<new value> item and type in a new value. To remove a value from the list, select value(s) and click the Remove 
Selected Value(s) button.

Raw data: negative values as layer
This option only applies to DEM files that use the raw data schema type. It places all negative values into a single 
Adobe Photoshop layer called "Negative Values".
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IMPORTANT NOTES

Mosaic DEM files
When mosaicking DEM files together, each file must have the same DEM schema and an appropriate Vertical Unit 
specified. It is important to know the data range of all the DEM files that will be mosaicked so that a DEM schema 
can be created that encompasses the highest and lowest elevation of all the DEM files.

Esri BIL files
When opening BIL files without a colour table, the Import DEM file dialog box will show the options to Open as 
raster image or Open as elevation data. When a colour table (.clr file) is present in the same folder as the BIL file, it is 
automatically opened as a raster image.

Find Elevation Value of a DEM
To find the elevation value of a DEM, it must be imported using a DEM schema. In the Georeference dialog box, the 
actual elevation value is displayed below the image preview. Move the mouse cursor to any position within the 
image view to see the values (updated in real time).

DEM Schema and Scripting 
The creation of DEM schema can not be recorded by Adobe ScriptListener or by using example scripts. Any DEM 
schema will have to be created prior to using automation.

Out of Range DEM Values
A warning is displayed when DEM files that contain low or high elevation values out of the shema range are 
imported. These out of range images may import incorrectly.
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Shaded relief is a method for representing topography on 
physical and digital maps in a natural and intuitive way.

The Terrain Shader tool provides options to customize and 
apply colours and hill shading to elevation data.

The topic covered in this section:
Terrain Shader

Terrain 
Shader 



100 Geographic Imager User Guide
Terrain Shader 

FUNCTIONALITY

The Terrain Shader tool provides options to apply color maps and shaded relief to supported elevation data formats 
(e.g. DEM, SRTM, etc.). There are two methods to apply a color map: stretch gradient along the image’s DEM schema, 
or use the preset color map. When color map or shaded relief parameters are applied, the preview image will 
update to show how the settings affect it.

Terrain Shader

Apply Shaded Relief 
Check to enable shaded 

relief options

Color Gradient 
Choose a custom or 

preset color gradient

Apply Color Map 
Check to enable color 

mapping for the image

Method 
Stretch gradient to the 

DEM schema or use a 
preset color ramp 

Color Gradient to  
Elevation map 

Displays how the color 
gradient is mapped to 

elevation using the 
image’s DEM schema

Apply only to selection 
Enabled when an area on 
the image is pre-selected

Angle  
Adjust the lighting angle

Preview Image 
Outlined in a dashed red 
line. Area outside crop 
area is grayed out.

Create single layer 
Creates a single coloriza-
tion layer when enabled. 
Uncheck to create mul-
tiple colorization layers 
for multiple DEM layers.

Use Continuous Color 
Smooths the color 
gradient. Uncheck 
option to use discrete 
color style.

Precision 
Regular precision creates 
an adjustment layer. 
Higher precision creates a 
raster layer.

Intensity
Adjust the aesthetic 
depth and sharpness of 
the shaded relief 
(intensity from 0 to 100)

Terrain Shader
Click the Terrain Shader button 
to open the Terrain Shader 
dialog box. 

Color map controls

Edit Selected Color Map 
Edit how the color map is 

stretched to the image’s 
DEM schema

Delete Color Map 
Remove the color map 

from the drop-down list

Import Color Map From File 
Import color maps from an 
external .grd or .xml file

Export Color Map to File 
Export the current color map or 
all color maps to .xml or current 
color map to a .grd file
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PREREQUISITES

Any image (except 32-bit images) can be manipulated with Terrain Shader. However, only images with elevation 
data can have its elevation values mapped to a color ramp or gradient. Images that do not have elevation data has 
its values stretched to a percentage of the color gradient. Terrain Shader is not available for images in Duotone or 
Bitmap color modes.

APPLY COLOR MAP

With an opened image, click the Terrain Shader button in the Geographic Imager panel to open the Terrain Shader 
dialog box. To apply color and shaded relief to the image, use the following options:

Ensure the Apply Color Map check box is checked (default). There are two available methods to apply a color map. 
Choose Stretch gradient along image’s DEM schema to extend the color gradient to the minimum and maximum values of 
the DEM schema. Choose a color gradient in the drop-down list to map it to the DEM schema. The Color Gradient to 
Elevation map to the left of the Preview Image updates to show how the color schema is stretched.

Choose Use preset color map to use only the colors specified in the gradient that fall within the range of the DEM 
schema. This does not stretch the color gradient to the minimum and maximum values of the schema. Choose a 
color gradient in the drop-down list to map it to the DEM schema. The Color Gradient to Elevation map to the left of 
the Preview Image updates to show how the color schema is stretched.

EDIT SELECTED COLOR MAP

Click the Edit Selected Color Map button  to edit how the color gradient stops and elevations are positioned. At 
the top of the Edit Color Map dialog box, the current gradient and color stops in it are displayed.

Color Stop 
Shows position of color 

stop that is part of the 
gradient. A black triangle 

on top means that it is 
highlighted for editing. 
Slide to adjust position.

Color Map Name 
Name of the color map

Low / High Elevation 
Respecify the lowest and 
highest elevation values 
to map to

Color Map table 
Shows how each color 

stop and its position (in 
percent) is mapped to 

the elevation. Click values 
and colors to edit them.

Add Color Stop 
Add a color stop to 

the color map

Delete Color Stop 
Delete the selected color 
stop from the color map

Clear Color Stops 
Delete all of the color 
stops from the color map

Reset Color Stops 
Reset the all of the color stops 
to its original settings when the 
dialog box was first opened.

Use Continuous Color 
Smooths the color gradient. 
Uncheck option to use 
discrete color style.

Gradient 
Composed of at least two 
color stops

Stretch Elevation Range 
Reassign elevation values 
to match the specified low 
and high elevation values
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Edit a Color Stop
The color map table shows how each color stop is mapped to a corresponding elevation value. To adjust the 
position of the color stop, click and slide it left or right. When a color stop is adjusted, the respective Elevation and 
Position values in the color map table are updated. Similarly, changes made directly to the color map table are 
reflected in the gradient color stop. The changes can be viewed in real time when the Update preview image in the 
Terrain Shader dialog option is checked.

To edit the color of a color stop, double-click either the color stop itself or the color square in the corresponding row 
in the color map table. A selected color stop is highlighted in the table and is designated by a black triangle in the 
gradient. In the Select Color for Color Stop dialog box, use the options available to choose a basic or custom color.

Use Continuous Color
Uncheck the Use Continuous Color check box to use discrete color breaks.

Add a Color Stop
Click the Add Color Stop button to add a color stop to the gradient. In the Select Color for Color Stop dialog box, use 
the options available to choose a basic or custom color. After a color stop is added, adjust its position by sliding it 
left or right in the gradient bar.

Delete a Color Stop
Click a color stop (in the gradient or color map table) to select it and click the Delete Color Stop button.

Clear Color Stops
Click the Clear Color Stops button to remove all color stops. A confirmation warning appears to confirm your decision.

Reset Color Stops
Click the Reset Color Stops button to reset all color stops to how they were when the Edit Color Map dialog box was 
first opened. This is particularly useful in situations where you may want to return to the original settings without 
closing the dialog box. A confirmation warning appears to confirm your decision.
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Adjust Low and High Elevation values
Specify new values in the Low and High Elevation boxes. Changing these values will alter the relative position 
(in percentage) for all color stops that are mapped to the elevation. When a specified color stop is not within the 
elevation range, the text is grayed out in the table (but can still be edited) and the color stop itself is not shown 
in the gradient (negative position value). If needed, edit the Elevation value to set it within range or set a positive 
Position value.

Stretch Elevation Range

Click the Stretch Elevation Range button  to specify new elevation range values. This is applied to all color stops 
and stretches them to the new specified range. The color stops maintain their relative position in the color map. 
However, when a specified color stop exceeds a position value greater than 100%, the text is grayed out in the table 
(but can still be edited) and the color stop itself is not shown in the gradient. If needed, edit the Position value so 
that it is less than 100%.

Save Color Map
Click the Save button to save the color map. There are two options to save the color map: update the base color map 
or save as a new color map. Specify a color map name if saving as a new color map. The new color map will appear 
in the Color Map drop-down list. When updating a base color map without saving it as a new color map, it will 
appear as (1) Custom: [color map name].

Precision
Terrain Shader has a precision setting that affects how colors are mapped to a DEM. The precision value is listed in 
the drop-down list (e.g. 0.3 m). A Regular precision setting quickly creates an Adobe Photoshop adjustment layer 
and a shaded relief layer at the cost of slightly lower precision. A Higher precision setting creates a colorized raster 
layer and a shaded relief layer, however, this process uses more memory and takes longer to calculate.

Note:	 The DEM precision (displayed in the Import DEM File dialog box) is different that the precision used in the 
Terrain Shader dialog box.

Create Single Layer
The Create Single Layer option is enabled by default when the Higher Precision setting is chosen. When checked, it 
creates a single colorization layer when multiple DEM layers are present. When disabled, each DEM layer will have 
its own colorization layer.
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DELETE COLOR MAP

Choose a color map from the Color Map drop-down list and click the Delete Color Map button  to remove it.

IMPORT COLOR MAP FROM FILE

Adobe Photoshop gradient and color map files can be imported as .grd and .xml files. Click the Import Color Map From File 

button  to open the dialog box and navigate to the files to import. View the details of the color map before 
import. The Gradient Name can be edited. Import All allows for multiple files to be imported at a time.

EXPORT COLOR MAP TO FILE

Adobe Photoshop gradient and color map files can be exported as .grd and .xml files. Click the Export Color Map to File 

button  and choose one of the following options: 
•	 To Xml File: exports the selection in the Color Map drop-down list to an .xml file
•	 All to Xml File: exports the entire Color Map drop-down list to an .xml file
•	 To Photoshop Gradient: exports the selection in the Color Map drop-down list to a .grd file.

A sample that shows the structure of the .xml file:
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APPLY SHADED RELIEF

Ensure the Apply Shaded Relief check box is checked (unchecked by default). The preview image is immediately 
updated to reflect the Angle and Intensity settings.

The Angle setting represents the lighting angle at which the elevation is rendered. Edit the value (degrees) in the 
Angle box or rotate the jog dial to the right of it. The lighting is global and affects the entire image. The default 
Angle setting is 45 degrees, a commonly used lighting angle.

The Intensity setting represents how soft are hard the lighting effect is. Edit the value in the Intensity box or use the 
slider. A lower intensity value creates a softer looking shaded relief (below left) while a higher intensity value creates 
a sharper looking shaded relief with more shadows and contrast (below right). The default Intensity value is 2; with 
a minimum of 0 and a maximum of 100.

      

The shaded relief can be applied on its own without a color map. Uncheck the Apply Color Map check box. The 
shaded relief will be uncolored.

APPLY COLOR MAP AND SHADED RELIEF ONLY TO SELECTION

It is possible to apply Terrain Shader only to a selection. Before opening the Terrain Shader dialog box, use any of 
the Adobe Photoshop selection tools (Marquee tool, Lasso tool, Magic Wand tool or Quick Selection tool) to create 
a selection (or multiple selections of the same layer).  Open the Terrain Shader dialog box and the Apply only to 
selection check box will be enabled. Check the check box (unchecked by default) to use the setting. A warning 
message will appear: 

Click OK to close the warning. Confirm the other settings in the Terrain Shader dialog box and click OK. Only the 
selected area will have Terrain Shader effects applied to it.
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RESULTS

After successfully applying a color map, the Adobe Photoshop color mode will change to RGB (and will maintain the 
respective 8 or 16 Bits/Channel). Depending on the precision setting chosen, an adjustment layer or full raster layer 
will be created along with a separate layer for the shaded relief in the Adobe Photoshop Layers panel. They can be 
hidden to reveal only the color map, the shaded relief or the elevation layer.

Regular precision Higher precision      

IMPORTANT NOTES

Terrain Shader is not supported with the following Adobe Photoshop color modes:
•	 Bitmap
•	 Duotone
•	 Indexed Color
•	 Multichannel

Applying color to images that do not contain elevation data
Color maps will only work correctly if the image was converted from a DEM by Geographic Imager (or using a 
similar software). If an image is generated from a DEM by some method that is unknown to Geographic Imager, 
there is no guarantee that color maps will work correctly. For example, an image that may use white (which is often 
the highest value) to represent low value areas, Geographic Imager and Adobe Photoshop will incorrectly apply 
color corresponding to the highest value to such areas. To prevent this from happening, use images converted by 
Geographic Imager.

Default color maps
The default color maps are stored in ColorMappings.xml in the \Avenza\Geographic Imager\Color Mappings folder.
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Advanced 
Import 

Advanced Import combines many Geographic Imager tools 
to open a wide range of raster formats. Use it to import 
multiple images, adjust source coordinate systems, manage 
color channels, specify DEM schemas, resample image sizes, 
GeoCrop, and mosaic.

Topic covered in this section:
Advanced Import
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Advanced Import

FUNCTIONALITY

The Advanced Import function imports images and provides useful settings to change reference file, source 
coordinate system, color channel managment, DEM schema, adjust image size and extents and even mosaic. It is 
also useful for quickly cropping large sized images to a specific geographic area which may have initially required a 
long load time.

Advanced Import
Click the Advanced Import button to open 
the Advanced Import dialog box. 

Import File List
Files listed here are for ready 
for import. Shows name, 
coordinate system, DEM 
schema (if applicable) and 
image dimensions. To add, 
click Browse. Click Delete 
to remove selected image 
from list.

Source Coordinate System
The current coordinate  
system of the selected 
image. To change it, click the 
coordinate system hyperlink  
or From File.

DEM Schema
The chosen DEM Schema 
(See Chapter 9). Click Specify 
to change to another DEM 
schema.

Mosaic All Files
Enable this option to  
perform a Mosaic  
operation (Chapter 5) on a 
selected destination 
document. 

Channel Management
For non-DEM images, this 
indicates the color mode. 

Click Modify to adjust 
channels in RGB, Lab or 

Grayscale modes.

Image Extents
This indicates the size of the 
image in pixels and file size 

in MB. Click Crop to perform 
a GeoCrop (see previous 

section). Click Resample to 
resize the image.

Reference File
Source of spatial reference 

information for the selected 
image. To change it, click  

the Specify button.

Format
Choose <Auto detect 

format> or choose a specific 
file format to browse for
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USING ADVANCED IMPORT

Click the Advanced Import button on the Geographic Imager panel. The Advanced Import dialog box appears. 
In the Format drop-down list, select an image format (or leave as <Auto detect format>) then click Browse. 
Alternatively, drag and drop files into the file list. These supported formats are compatible with Advanced Import:

•	 Web Map Service
•	 ArcInfo ASCII Grid
•	 ArcInfo Binary Grid
•	 ArcInfo Binary Float Grid
•	 BIL
•	 GeoTIFF*/BigTIFF/TIFF

•	 DEM USGS CDED ASCII
•	 ECW
•	 ERDAS IMAGINE Raster
•	 JPEG 2000
•	 Military Elevations Data/DTED
•	 MrSID

•	 NITF
•	 PCI EASI/PACE
•	 SDTS Transfer
•	 SGI
•	 SRTM

* Adobe Photoshop layers are not supported when imported through Advanced Import. Multi-layer GeoTIFF files will be flattened.

Multiple images of varying formats can be imported at a time and are shown in the Import File List. Additional 
information including coordinate system, DEM schema (if applicable), and image dimensions are shown in the 
list. When a file is selected in the list, it enables or updates the Reference File, Source Coordinate System, Channel 
Management (if applicable), DEM Schema (if applicable), and Image Extents areas below it. As settings in the dialog 
box are changed, the file list will update. To remove a file from the list, click to select it, then click the Delete button.

Reference File
The accompanying reference file is displayed in this area (e.g. boston.tfw). To change the reference file, click Specify 
and browse for a new one. See chapter 3 for more information.

Source Coordinate System
The coordinate system used in the reference file is displayed in this area (e.g. NAD27). To specify a new a new 
coordinate system, click the coordinate system hyperlink to open the Specify Source Coordinate system dialog box 
(see chapter 4). Alternatively, choose a coordinate system from a file or assign a coordinate system from an existing 
image in the File Import List.

Channel Management
The color mode is displayed in this area (e.g. RGB Color - 3 channel). To edit how the color mode channels are 
assigned, click the Modify button to open the Channel Management dialog box. Change the Color Mode in the 
drop-down list. Click a channel role color drop-down list to assign that specific channel a new color. These changes 
are displayed in the list and will be reflected in the Adobe Photoshop Channels panel.

Note:	 Color Mode is not available for images imported from a Web Map Service.
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DEM Schema
The DEM schema is displayed in this area (e.g. Auto-stretched) (and is only applicable to DEM files). To change the 
schema, click the Specify button to open the Import DEM file dialog box (see chapter 9). The Import DEM file dialog 
box provides options to apply a schema (custom , preset or saved) based on the statistics of the raster data set. Use 
the Include DEM value range as part of the Auto-stretch schema setting when importing multiple files that may be of 
similar data range or geographic location. This will find the minimum and maximum values of all DEM files and use 
a broader range than just a single file (indicated in the DEM Schema as Combined.) To apply the same DEM schema 
to all files, ensure that the Apply to all DEM files in import list is checked.

Image Extents, Crop and Resample
The image extents of the selected file is displayed in this area (in pixels). Also displayed are its scale and raw file size. 
There are two options available here: Crop and Resample. Click the Crop button to open the GeoCrop dialog box 
(see chapter 7) to crop the image. Click the Resample button to open the Resample Image dialog box to adjust the 
size of the image by width/height or percentage value. 

Notes:	 When a crop is performed on a DEM with Auto-stretched schema type, the DEM schema in the file list will 
update to specify it as Crop auto-stretched. 
 
To crop WMS data, use the Crop tool in the Select Web Map Layer dialog box when choosing a WMS layer. 

Mosaic All Files
When an image is already open or more than one image is listed in the Advanced Import dialog box, the Mosaic All 
Files option is available. Enable the option and choose the appropriate destination document to mosaic into (either 
an existing open document or one of the images listed). The destination document changes depending on which 
listed image is selected. The images will mosaic upon import. See chapter 5 for more information about Mosaic.
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ADVANCED IMPORT NOTES

Any image with mulitple layers will be flattened. As a result of this, any transparency that exists on layers is lost, 
however, Channels are preserved. To maintain transparency, use the File > Open command instead. 
 
Some formats supported using Advanced Import cannot be saved back to its original format by Adobe Photoshop 
or Geographic Imager. It is required to save it in a format supported by Adobe Photoshop (e.g. TIFF, JPEG, Geospatial 
PDF, etc.) The image maintains georeference with a new reference file (specified in Geographic Imager Preferences). 
 
When a DEM is imported with Advanced Import, the data range that will be applied on the final imported image 
will be the "auto-stretched" option. However, if a new schema is added during import, the data range of whole file 
will be used, not the data range of the cropped image. 
 
Image rotation may not be read with some files exported from ArcGIS (it may display "N/A" next to rotation in the 
Geographic Imager panel).

When importing data using a Web Map Service, the "Set Background Transparent" option is only a suggestion for 
the server to create a transparent background. The WMS server may ignore this request, which will result in an 
opaque background.
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Geographic Imager saves georeferenced images with 
full georeferencing properties thus offering limitless 
possibilities for continuously modifying files without the 
worry of losing the georeferencing.

This chapter will provide information on how to save 
georeferenced images in a proper image format, as well 
as exporting defined coordinate systems. 

Topics covered in this section:
Save and Export

Save and 
Export
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Geographic Imager is able to save to all supported Adobe Photoshop image file formats. When saving a 
georeferenced image to a non-geospatial format, Geographic Imager creates an accompanying reference file.

SAVE IMAGE FILES WITH GEOREFERENCING

Geographic Imager can write to the following spatial image formats: GeoTIFF, BigTIFF, Geospatial PDF, NITF and 
ECW. When working with one of these formats, simply use the Adobe Photoshop Save command to save the 
image and to update the reference file (internal or external). To save to one of these spatial image formats, use the 
Adobe Photoshop Save As command and choose the appropriate format in the Format drop-down list. Note that 
GeoTIFF is simply represented in the Adobe Photoshop Save As dialog box as TIFF (*.TIF, *.TIFF) and geospatial PDF 
is represented as Photoshop PDF (*.PDF, *.PDP). Depending on the originating image format, certain format types 
may not be available during save.

During a Save As process, each supported format may have a native Adobe options dialog box. For example, when 
saving as a GeoTIFF, the TIFF Options dialog box will appear. When saving as Photoshop PDF, the Save Adobe PDF 
dialog box will appear. The following Geographic Imager format option dialog boxes will appear for BigTIFF and 
ECW formats:

When saving to a non-spatial image format (e.g. JPEG or PNG), an accompanying reference file is created in the 
same name. The type of reference file is dependent on the one chosen in the Geographic Imager Preferences (see 
chapter 14). For example, an image with the file name VancouverCity.jpg will have an accompanying reference 
file VancouverCity.tfw (World reference format). Some image formats, such as GeoTIFF, contain georeferencing 
information internally and no external reference file is created. When saving to another image format using the 
Save As command, Geographic Imager will prompt that an external reference file must be saved. All supported 
reference file types will be listed and one must be selected to save the image with georeferencing.

Geographic Imager automatically updates associated reference files based on the latest transformation settings 
when saved.

Caution:	 When saving an image after a Geographic Imager function is performed, Geographic Imager automatically 
updates the reference file. In this process, the original reference file is overwritten. In order to avoid 
damaging the original image and reference files, use the Save As command with a new file name or file 
location rather than using the basic Save command.

Save and Export
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Notes:	 When saving to BigTIFF format, an image that has more than four color bands cannot be saved using the 
JPEG image compression option. For BigTIFF images in RGB or Grayscale color mode, using the JPEG image 
compression option only supports 8 bit RGB, RGBK or grayscale with less than four bands. Caution should be 
used when saving to BigTIFF using a script because it is possible to use the JPEG image compression option 
(doing so will produce incorrect results). 
 
Saving and opening a BigTIFF in LAB color mode is only supported with Geographic Imager 3.3 and later.

EXPORT COORDINATE SYSTEM DATA

The defined coordinate system can be exported as a WKT Definition File (.wkt) or Esri Projection file (.prj) through 
the Geographic Imager panel options menu. Select Export Coordinate System from the panel options menu to access 
the Export dialog box. 

Some reference files that do not store the coordinate system information will benefit from a WKT Definition File or 
Esri Projection file. These files stores all the parameters of the coordinate system that was exported.

Some projections are not supported when saving a reference file and will not store the coordinate system. See 
Chapter 2 - Georeference Formats.

EXPORT A REFERENCE FILE

The defined coordinate system for a georeferenced image can be exported as a reference file through the 
Geographic Imager panel options menu. Select Export Reference File from the options menu and choose from the list 
of available reference file format options: Blue Marble Reference File (.rsf ), ER Mapper (.ers), GeoTIFF (.tif )*, MapInfo 
TAB File (.tab), World Files (.tfw, .tifw, .wld, .jgw, .pgw, .sdw, .eww, .blw, .dmw, .bpw) and geospatial PDF (.pdf )**.

Export functionality may also be used to change the referencing file format of an image. The georeferencing 
information should be first exported into the desired reference file format. Then click the Reference File link in the 
Geographic Imager panel to specify it as the new reference.

*	 The GeoTIFF option is only available if the current image format is TIFF. Exporting a reference file to GeoTIFF is 
another way to convert a non-spatial TIFF to GeoTIFF.

**	 The geospatial PDF option is only available if the current image is an Adobe Photoshop generated geospatial 
PDF. Use the Quick Save to Geospatial PDF option, see next page.

Note:	 If referencing of an image was changed after export, only the current referencing file will be updated; 
previously exported reference files will not be deleted or updated. The current reference file will be used and 
the old reference file will not. Keep this in mind when reopening images.
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QUICK SAVE TO FORMAT

Available through the Geographic Imager panel options 
menu, the Quick Save to Format command provides the 
ability to save a georeferenced image as another format. 
It supports saving to Geospatial PDF, GeoTIFF, NITF, ECW, 
BigTIFF, and ERDAS IMAGINE Raster. It functions similarly 
to the Adobe Photoshop Save As command, except that 
it uses default settings to expediate the save process.

Quick Save to GeoTIFF Notes

The Quick Save command is available when the open 
image is not a GeoTIFF (e.g. a JPEG or a TIFF with a 
.tfw reference file). There is no external reference file 
because all of that information is stored in the GeoTIFF. 
If the file is already a GeoTIFF, the option to Quick Save 
to GeoTIFF will be unavailable. Just use Save or Save As 
to save an existing GeoTIFF.

Note:	 Quick Save to GeoTIFF cannot be used with 
Adobe Photoshop Multichannel images. Instead, 
convert to RGB mode first (it will keep the 
additional channels), then save.

Quick Save to Geospatial PDF Notes

The Quick Save to Geospatial PDF command exports any open image with a specified coordinate system to the 
Adobe Acrobat Geospatial PDF format. There is no external reference file associated with it because it retains all of 
the georeference information within the PDF itself. It is exported using the Adobe Acrobat PDF 1.7 specification 
which is fully compatible with Adobe Acrobat 9 and later.

The Adobe Acrobat Analysis Tools allow viewing and marking coordinates, viewing attributes, measuring distances, 
perimeters and areas. With Acrobat Pro and Pro Extended, the measurement tool is always enabled. To enable this 
tool in Acrobat Reader 9 (standard), the file must first be opened in Acrobat Pro to enable annotations on the PDF 
(menu Comments > Enable for commenting and analysis).

See chapter 2 for more information about viewing geospatial PDF files.

Note:	 32-bit images are not supported for export to geospatial PDF.
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Quick Save to Format Defaults

These are the default save settings when using Quick Save to Format:

•	 GeoTIFF: Image Compression = JPEG (Quality=75), Pixel Order = Interleaved
•	 GeoSpatial PDF: Default Adobe Photoshop Save settings
•	 ECW: Reduction = 75
•	 NITF: No Settings
•	 BigTIFF - Geographic Imager: Image Compression = JPEG (Quality=75), Pixel Order = Interleaved
•	 ERDAS IMAGINE Raster: Block Size = 64, Pixel Type = Default

EXPORT PATHS TO ADOBE ILLUSTRATOR

From the File menu, use the Adobe Photoshop Export > Paths to Illustrator function to generate an Adobe Illustrator 
document that contains vector layers created in Photoshop. By default, an option to export an RSF file to capture 
spatial referencing information is enabled in the Geographic Imager Preferences.

To use the exported files, ensure MAPublisher (8.3 and higher) is installed. Open the Adobe Illustrator document 
that contains the artwork. In the MAP Views panel options menu, click New MAP View For Photoshop Paths. In this 
dialog box, browse for the RSF file to import the referencing information. 

 
The New MAP View For Photoshop Paths dialog box in MAPublisher for Adobe Illustrator.

Use this workflow to easily bring vector paths and spatial images together.

Note:	 The New MAP View For Photoshop Paths feature is not compatible with Adobe Illustrator CS3.
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Geographic Imager supports the use of actions and 
scripts to help automate repetitive tasks.

This chapter provides information on how to use 
actions and scripts to automate Geographic Imager.

Topics covered in this section:
Automating Geographic Imager

Automating 
Geographic 
Imager 
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Adobe Photoshop actions and scripts are supported in Geographic Imager and can be automated using Javascript 
and actions (but currently not with Visual Basic or Applescript).

Actions and scripts automate repetitive tasks and will greatly assist in time consuming manual tasks. Scripts have a 
benefit over actions because conditional logic can be written into them so that it can make decisions based on the 
current task. Scripts can also involve multiple applications. Another benefit is that it can use variable paths while 
actions only use an absolute path of the file location. Since scripts are written in Javascript, they are cross platform 
compatible and will work with different computers, whereas actions may not always work with different systems.

Scripts can be viewed and edited in any text editor such as TextEdit and Notepad as long as the extension 
remains as jsx. Ideally, scripts should be created and run using Adobe ExtendScript Toolkit 2 supplied with Adobe 
Photoshop. This application provides many debugging tools and assistance with creating scripts. Scripts can also be 
created using the Adobe plug-in, ScriptListener, that is installed with Adobe Photoshop. Actions are recorded into 
a log and is used to create a script. The ScriptListener plug-in is located in \Adobe\Adobe Photoshop CS5\Scripting\
Utilities. Please refer to the Adobe Scripting Guide for more information on scripting located in \Adobe\Adobe 
Photoshop CS5\Scripting\Documents\Photoshop CS5 Scripting Guide.pdf.

UNSUPPORTED / SUPPORTED FUNCTIONS

Adobe Photoshop operations used in actions or scripts will maintain georeferencing information. Please note that 
there are some functions that are not yet supported due to Adobe Photoshop API limitations.

Supported Functions
•	 ExtendScript Toolkit 2
•	 Run script using File > Scripts > Browse
•	 Run script by double-clicking script
•	 Run script by drag-and-drop into Adobe Photoshop
•	 Run action using Action Panel
•	 File > Automate > Batch, where the Source drop-down list is set as Folder or Open Files.
•	 File > Automate > Batch, where the Destination drop-down list is set as None or Save and Close.
•	 Actions that run a script or another action
•	 Scripts that run another script or action
•	 Actions that run a script or action that run another script or action
•	 Scripts that run a script or action that run another script or action

Unsupported Functions
•	 Adobe Photoshop closed when using automate tools
•	 Insert menu item from Action panel
•	 Script Events Manager
•	 Create Droplet
•	 Image Processor
•	 File > Automate > Batch, where the Destination drop-down list is set as Folder. Specifying new folder names and 

new file names are unsupported.
•	 File > Automate > Batch, where the Source drop-down list is set as Advanced Import. The action is not completed 

because Advanced Import parameters have to be set manually.

Automating Geographic Imager
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CREATING ACTIONS AND SCRIPTS

It is important to note that the Geographic Imager panel buttons, links and option menu can not be detected using 
actions or scripts with the ScriptListener plug-in. Therefore, to record actions or scripts with Geographic Imager, use 
the following menu items from the File > Automate menu:

Geographic Imager: Export Coordinate System
Used when recording an action to export the coordinate system of an image.

Geographic Imager: Export Reference File
Used when recording an action to export the reference file of an image.

Geographic Imager: GeoCrop 
Used when recording an action to perform a GeoCrop on an image.

Geographic Imager: Georeference 
Used when recording an action to perform georeferencing.

Geographic Imager: Mosaic 
Used when recording an action to mosaic an image.

Geographic Imager: Quick Save To Format
Used when recording an action to create a geospatial PDF, GeoTIFF, BigTIFF, NITF and ECW/ERMapper for all other 
reference formats.

Geographic Imager: Show Panel
Show/hide the Geographic Imager panel.

Geographic Imager: Specify Coordinate System
Used when recording an action to specify the coordinate system of an image.

Geographic Imager: Specify DEM Schema
Used when recording an action to specify the DEM schema of an image.

Geographic Imager: Specify Reference File
Used when recording an action to specify the reference file of an image.

Geographic Imager: Terrain Shader
Used when recording an action to apply color or hill shading to an image.

Geographic Imager: Tiling 
Used when recording an action to tile an image.

Geographic Imager: Transform 
Used when recording an action to perform a coordinate system transformation.
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USING SCRIPTS TO AUTOMATE GEOGRAPHIC IMAGER FUNCTIONS

There are two primary methods to create scripts for Adobe Photoshop. The first method requires basic familiarity 
with the Adobe Photoshop object model and basic JavaScript programming skills. For structured scripts, use 
functions conveniently provided in the GeographicImager.jsxinc file that wrap low-level Adobe Photoshop calls to 
Geographic Imager functionality. The second approach to create scripts involves using the Adobe ScriptListener 
plug-in that records actions performed by the user (including those of Geographic Imager) and stores the results as 
a ready-to-execute text script-file. While it may allow to quickly create a script that performs the required sequence 
of action, the automatically created script is somewhat harder to modify and maintain, since it contains all the 
parameters hard-coded (such as paths to files). It is also harder to read and less structured, as it directly invokes 
Adobe Photoshop low-level functions by directly populating so-called Adobe Photoshop descriptors with the 
parameters required for each Adobe Photoshop or Geographic Imager command. If you choose to record your 
scripts using the Script Listener, you may want to carefully read GeographicImager.jsxinc to learn about the specific 
parameters that can be passed to Geographic Imager commands.

Refer to Adobe scripting documentation, Adobe forums (http://forums.adobe.com) and third-party sites that 
provide helpful information regarding scripting Adobe Photoshop functionality.

Geographic Imager installs a directory named SampleScripts located at:

Windows XP: C:\Program Files\Avenza\Geographic Imager\User Guide, Tutorial & Data\Tutorial Data\Sample Scripts
Windows Vista/7: C:\Users\Public\Documents\Avenza\Geographic Imager\User Guide, Tutorial & Data\Tutorial Data\Sample Scripts
Mac OS X: /Application/Avenza/Geographic Imager/User Guide, Tutorial & Data/Tutorial Data/SampleScripts

•	 ScriptExamples.jsx, provides information on all Geographic Imager scripting functions and samples.

•	 ScriptBatchProcessingExample.jsx, contains an example script for batch processing.

•	 Rocky Mountains.jsx, used with the Geographic Imager Tutorial Guide.

Notes:	 Two separate folders, StartupRegistrationScripts and IncludeScripts contain scripts used to enable actions and 
scripting for Geographic Imager. These folders and its contents should not be renamed or deleted.  
 
Scripted Adobe Photoshop actions that trigger Geographic Imager dialog boxes (e.g. saving a non-compliant 
document) will always assume a "show-errors-only" mode. 
 
Geographic Imager dialog boxes, sub-dialog boxes or warnings that may appear during the execution of 
supported functions should respect whatever option is passed to them. Only the option that is explicitly 
scriptable through script parameters (and also displayed as action parameters if run from an action) will be 
recorded. All others will assume their default selections. This can be changed by checking the "Don’t show 
again" option (wherever it applies). 
 
Due to Adobe Photoshop API limitations, Geographic Imager does not automatically read georeferencing 
from a geospatial PDF when it is opened using a script or action. 
 
Unicode characters are not supported for DEM schema names when used in a script.
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The following examples are taken from the file ScriptExamples.jsx:

Creating Scripts for Geographic Imager Functions

At the beginning of a new script, the following code is required when scripting Geographic Imager functions:

// IMPORTANT: If you have installed Geographic Imager to a custom directory please 
update the path below to your directory/path.

// Geographic Imager installed for Adobe Photoshop (32 bit)
#includepath "/C/Program Files (x86)/Avenza/Geographic Imager/IncludeScripts"

// Geographic Imager installed for Adobe Photoshop (64 bit)
#includepath "/C/Program Files/Avenza/Geographic Imager/IncludeScripts"

// For Mac platform
#includepath "/Applications/Avenza/Geographic Imager/Geographic Imager Plug-in/ 
IncludeScripts/"

// include required Geographic Imager subroutines
#include "GeographicImager.jsxinc"

This section refers to the location of files needed to run a script using Geographic Imager functions. To use 
scripts on any platform, include all of the #includepath. However if the script is platform specific, only the 
#includepath for the platform intended to run the script is needed. Refer to the following section to create a script 
using Geographic Imager functions.

Note:	 The above code is not needed if using ScriptListener to script Geographic Imager functions.

Specify Reference File Script Example

Specifies a reference file to the current document when not automatically detected. The location and the name of 
the reference file must be specified. The type of reference file must also be specified, in this case it is a World file. 

SpecifyReferenceFile("C:/temp/reference.tfw", giFormatWorld);
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Specify Coordinate System Script Examples

This example specifies the coordinate system, if the reference file does not contain coordinate system information:

SpecifyCoordinateSystem("", "WGS84_coordinate_system");

The above uses the WGS84 Coordinate System. This example leaves the issuer empty. If one is not specified, the 
default issuer is GC. WGS84_coordinate_system is the code taken from the issuer GC. This information is obtained 
from the Coordinate System Viewer dialog box (the Identification tab in this dialog box has a list called Identifiers, 
which contains the Issuer/Code pairs).

The following example specifies the WGS84 Coordinate System using the issuer EPSG: 

SpecifyCoordinateSystem("EPSG", "4326");

Transform Script Examples

The following performs a transformation to British Nation Grid:

Transform("", "NATIONAL-GRID");

This does not change pixel size, or resampling for a transformation. The strip size and other options will be used 
from the last transformation. Resampling method and pixel size are optional parameters. When an issuer is not 
specified, GC is used.

This example performs a transformation to the British National Grid (EPSG 27700):

Transform("EPSG", "27700", 1228, giResamplingCubic);

This changes the destination pixel size to 1228 ground units (meters, in this case) and uses the resampling method 
of Bicubic.

The following example performs a transformation based on another open image’s coordinate system. Running this 
script requires two open images. This performs the same function as using ‘Same As’ in the Transform dialog box.

var documentRef = FindDocumentRefByDocumentTitle("mydocument.tif");
  if( 0 == documentRef ) {
    alert("The required document is not open.");
  }
TransformAs(documentRef, giResamplingCubic)

See ScriptExamples.jsx for more Transform script examples.
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Convert to Format Script Example

This creates a new GeoTIFF with the file name appended to the directory of the active document:

ConvertToFormat("giTiffPluginName", "C:/temp/reference.tif")

Convert to another format using format giGeoPDFPluginName, giECWPluginName, giNITFPluginName, or 
giBigTIFFPluginName. Create a new document in a different folder by specifying a new folder path.

Georeference Script Examples

This uses a list of points to reference, sets a transform method using the function setTransformMethod, and chooses  
a WGS84 coordinate system:

var command = GeoreferenceByPoint(); 
    command.addPoint("point1", 0, 0, -2.888888888, 59.999999999); 
    command.addPoint("point2", 419, 0, 1.766666666, 59.999999999); 
    command.addPoint("point3", 0, 452, -2.888888888, 54.977777777); 
    command.setTransformMethod(giGeoreferenceTransformAffine); 
    command.setMaintenanceMode(giGeoreferenceStandardMode); 
    command.setCoordinateSystem("", "WGS84_coordinate_system"); 
command.execute();

This sets the format of the reference points (in this case Delimited DMS):

var command = GeoreferenceByPoint(); 
    command.addPoint("point1", 0, 0, "-2 53 20.00000026", "60 00 00.00000000"); 
    command.addPoint("point2", 419, 0, "1 45 59.99999957", "60 00 00.00000000"); 
    command.addPoint("point3", 0, 452, "-2 53 20.00000026", "54 58 40.00000018"); 
    command.setFormat(giFormatDelimitedDMS); 
command.execute();

See ScriptExamples.jsx for more Georeferencing script examples.

Terrain Shader Script Examples

This script sets a color map called World, uses a default stretch type, applies shaded relief angle of 45 degrees and 
intensity of 2, and uses higher precision.

command = TerrainShader();
    command.setColorMapName("World");
    command.setStretchType(giTerrainShaderStretchTypeStretchBySchema);
    command.setUseContinuousColor(true);
    command.setShadedRelief(45, 2);
    command.setApplyToSelection(false);
    command.setHigherPrecision(true);
command.execute();
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GeoCrop Script Examples

This crops an image by pixel value:

GeoCrop(100, 100, 300, 300);

This crops an image by specifying the unit type (as long as the document supports it):

GeoCrop("-2 40 40.00000800", "54 04 00.00001200", "1 09 20.00001600",  
"50 55 19.99999200", giGeoCropGeodeticType, giFormatDelimitedDMS);

See ScriptExamples.jsx for more GeoCrop script examples.

Tile Script Examples

This tiles an image by number of tiles. Four in total (two columns, two rows):

TilingByNumberOfTiles(2, 2, "C:/temp/tile");

This tiles an image based on size of tiles:

TilingBySizeOfTiles(300000, 300000, giTilingUnitsGroundUnits, "C:/temp/EuropeTL.tif");

See ScriptExamples.jsx for more Tile script examples.

Mosaic Script Example

This script opens four images, calls the Mosaic function, sets the destination document, defines the three other 
images to be mosaicked, and finally mosaics the image (crop into current canvas option disabled by default):

command = Mosaic(); 
    command.setDestinationDocument("C:/temp/EuropeTR.tif"); 
    command.addSourceDocument("C:/temp/EuropeTL.tif"); 
    command.addSourceDocument("C:/temp/EuropeLL.tif"); 
    command.addSourceDocument("C:/temp/EuropeLR.tif"); 
    command.setResamplingMethod(giResamplingNearestNeighbor); 
    command.setProcessLayerOption(giProcessLayersMerge); 
    // command.setCropIntoCanvas(true); 
command.execute();

See ScriptExamples.jsx for more Mosaic script examples.
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Geographic Imager offers the flexibility of user-defined 
preferences for a variety of functions to help you save 
time and customize Geographic Imager to your own 
personal liking.

In this chapter you will learn how to set the Geographic 
Imager Preferences and select the appropriate option for 
your needs.

Topic covered in this section:
Geographic Imager Preferences

Preferences 
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Geographic Imager Preferences

Geographic Imager has preference settings that users may select and edit as desired. The Preferences panel can be 
accessed from the Geographic Imager panel options menu.

Open/New: use internal referencing  
format if available

This option overrides the chosen Default Reference 
Format when any internal reference is detected. 

This option is checked by default.

Format change: use internal referencing  
format if applicable

This option overrides the chosen Default Reference 
Format when any internal reference is detected. 

This option is checked by default.

Reset all Warning Dialogs
All Geographic Imager warning 
dialogs that were disabled by 
checking "Don’t show again" will 
be enabled and will be shown the 
next time they are applicable

Save GeoTIFF: reference method 
When saving to GeoTIFF, keep existing 

pixel reference point of current image or 
override by choosing: 

Pixel-As-Area (upper left corner), 
or Pixel-As-Point (center of the pixel)

Default Reference Format
Lists all the supported reference file formats 

(excluding GeoTIFF). When multiple reference 
files are found in the same directory the 

Reference File Ambiguity dialog box will be 
prompted listing the multiple reference files. 

Scripting/Actions Support 
Check this option to disable/enable 
scripting/action functionality

Save a copy of georeference as an RSF 
file on Export -> Paths to Illustrator 
Check this option to disable/enable the 
export of an RSF file when the Paths to 
Illustrator feature is used. See Chapter 9.

The following options may be adjusted 
according to individual preferences:

•	 Default reference format

•	 Use internal referencing format

•	 GeoTIFF reference method on Save

•	 Save a copy of georeference on export 
paths to Adobe Illustrator

•	 Enable Scripting/Actions support

•	 Reset all warning dialogs
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DEFAULT REFERENCE FORMATS

The options for Default Reference Formats are:

•	 World files

•	 MapInfo TAB files

•	 Blue Marble Reference files

•	 ERS files

When multiple reference files are found in the same directory the Reference File Ambiguity dialog box will be 
prompted listing the multiple reference files. The default reference format will be selected in the list, checking the 
option to always use the default reference format if available will not show the Reference File Ambiguity dialog box 
again and always use the default reference format.

Note:	 Only reference files with the same name as the image are listed in the Reference File Ambiguity dialog box. 
Reference files with a different name than the associated image will have to be specified manually.

When the Open: or Save: always use internal referencing format if available check box is checked, Geographic Imager 
uses any internal reference files (such as GeoTIFF) as the default and overrides the selection from the Default 
Reference Format drop-down list. This check box is checked by default. When georeferencing an image, the chosen 
format in the Default Reference Format drop-down list will be created.

SCRIPTING/ACTIONS SUPPORT

When the Scripting/Actions Support check box is checked, Geographic Imager will be able to interact with scripted 
or automated functions and users can properly automate Geographic Imager functionality (recommended). If no 
scripts or actions will be used with Adobe Photoshop, disable scripting/actions support in the Geographic Imager 
Preferences dialog box. This may increase the start-up performance of Adobe Photoshop. It will also reduce the 
chance of any conflicts on startup with other third-party plug-ins or scripts. See chapter 13 for more information 
about automating Geographic Imager.
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AFFINE AND POLYNOMIAL SOLUTION MODELS

Referencing method determines the mathematical model that is used to translate a coordinate of a pixel to the 
point on the plane of projection, or vice versa.

The most commonly used method is affine referencing. Mathematically, an affine transformation is any 
transformation that preserves collinearity (i.e., all points lying on a line initially still lie on a line after transformation) 
and ratios of distances (e.g., the midpoint of a line segment remains the midpoint after transformation). In this 
sense, the regular maps we are working with are affinely referenced to their respective plane of projection. Any 
images that are open in the Standard mode, where only the transformation is being maintained, are affinely 
referenced. The affine method requires a minimum of three reference points defined and included in the reference 
point list. This transformation type should generally be applied when referencing large scale maps (1:100,000 or 
less) published in a nearly rectilinear map projection such as the Mercator or Transverse Mercator.

For the purpose of GCP transformations, more than three points are commonly provided and more precise 
polynomial approximations should be used. This can provide better referencing than the basic affine method (e.g. 
a distorted image or approximate coordinate system information). The basic rule is that the more points that are 
provided, the higher degree polynomial can be used as there is a minimal requirement on the number of points for 
each method:

•	 Linear (first order) Polynomial Transform: minimum of 3 points

•	 Quadratic (second order) Polynomial Transform: minimum of 6 points

•	 Cubic (third order) Polynomial Transform: minimum of 10 points

•	 Quartic (fourth order) Polynomial Transform: minimum of 15 points

•	 Quintic (fifth order) Polynomial Transform: minimum of 21 points 

Please note that transformation of an image with a large set of GCP points should provide the best results, but 
using an affine or a low-polynomial referencing is unlikely to take advantage of this additional data. The shape of 
the resultant image may be similar to the original one. Having the sufficient number of points does not guarantee 
that the highest degree polynomial available will result in a plausible solution; a trial-and-error approach may be 
appropriate to obtain the best results.
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PIXEL REGISTRATION

The coordinate information shown in a World file (tfw) and the Geographic Imager panel are different because 
World files use the center of the pixel to derive coordinate information while the Geographic Imager panel uses: 
1) the top left corner coordinates of the pixel placed on the very top left corner of the image; and 2) the bottom 
right corner coordinate of the pixel placed at the very bottom right corner of the image. The second and third 
values in the World file are zero because there is no rotation or skew.

    

XY coordinates at 
bottom right corner

Image size: 3135 px by 2939 px

2.8 meters = 1 px

XY coordinates at
top left corner

When saving to GeoTIFF, it is possible to choose a different reference method: Pixel-As-Area or Pixel-As-Point.  
Pixel-As-Area uses the upper left corner of a pixel as registration. Pixel-As-Point uses the center of the pixel as 
registration. A Geographic Imager preference (Chapter 13) allows you to keep existing pixel reference point of 
current image or override by choosing Pixel-As-Area or Pixel-As-Point.
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MEMORY RECOMMENDATIONS

Occasional Users
A minimum of 2 GB RAM is required. These are graphics or GIS users who use Geographic Imager with medium 
sized data sets including some low-resolution or small coverage raster images.

Power Users
The recommended memory for a power user is 4 GB RAM or more. These are professional cartographers and GIS 
users who use Geographic Imager daily and works with large image files.

Memory Usage Hints
Users often ask us why is so much RAM needed to operate Geographic Imager. First of all, Adobe Photoshop 
requires a significant amount of RAM itself in order to run smoothly. Secondly, imagery data sets are often large 
which increases the need for RAM even further. Image data sets contain raster data which must be stored in 
memory. Since we are adding georeferencing properties to Adobe Photoshop, this increases the file size, which 
increases the RAM requirements. In addition, Adobe Photoshop loads the entire file into memory rather than just 
reading it from disk, thus more RAM memory is required.

When importing a large number of files into Adobe Photoshop using Geographic Imager, notice that the amount 
of available memory will decrease rapidly and the computer may lose performance. This is due to the memory 
management. Geographic Imager reserves a fairly large amount of memory for each action, which may not properly 
returned when the procedure is done. The solution is simple: save your file, close it and open it again. It’s not even 
necessary to close Adobe Photoshop itself. By closing the file,  the reserved memory is properly returned.

Memory Saving Tips
Many raster data files are large and when a series of such files is opened, you may find that the program starts to run 
more slowly. This is because scratch and memory allocations are being used up. The best solution is to periodically 
save your work, quit out of Adobe Photoshop and then restart. This will free up the available scratch memory.

The minimum number of undos can be reduced (since they all reside in memory).

You can set a primary and secondary scratch disk under the Photoshop preferences option in order to draw 
additional storage from a partitioned or multi-drive environment.
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ADOBE PHOTOSHOP PLUG-INS DIRECTORY

Windows XP, Vista and 7:
•	 Dutch: C:\Program Files\Adobe\Adobe Photoshop [CS version]\Insteekmodules

•	 English: C:\Program Files\Adobe\Adobe Photoshop  [CS version]\Plug-Ins

•	 French: C:\Program Files\Adobe\Adobe Photoshop [CS version]\Modules externes

•	 German: C:\Programme\Adobe\Adobe Photoshop [CS version]\Zusatzmodule

•	 Italian: C:\Programmi\Adobe\Adobe Photoshop [CS version]\Plug-In

Mac OS X: 
•	 /Applications/Adobe Photoshop [CS version]/Plug-Ins

GEOGRAPHIC IMAGER LICENSE FILE LOCATION

The Geographic Imager license file must be located as follows:

Windows XP: C:\Documents and Settings\All Users\Application Data\Avenza\Geographic Imager
Windows Vista and Windows 7: C:\ProgramData\Avenza\Geographic Imager
Mac OS X: /Applications/Avenza/Geographic Imager/Geographic Imager Plug-In

* English versions only. Location may differ in other Adobe Photoshop language versions.
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TECHNICAL SUPPORT OPTIONS

Please consult this user guide as well as the following online options before contacting Avenza technical support as 
your situation may be easily addressed by one of the answers contained therein.

Geographic Imager User Forum
The Geographic Imager User Forum is located at http://www.avenza.com/forum. Answers to common technical 
questions may be found in the Common Support Issues and FAQs category. All users with a Geographic Imager license 
(evaluation or permanent) can post and read topics under the General Questions for Evaluation & Licensed Users category. 
Additionally, users with maintenance have access to the Maintenance Users category. There, users can find additional 
information relative to software updates and other important details pertaining to maintenance.

Contacting Avenza Technical Support
Avenza offers a number of methods for direct communication with our qualified and experienced technical experts. 
Please have your Geographic Imager registration details handy to get prompt attention and include it in any e-mail 
correspondence. Support issues are handled on a first come, first-served basis. There is a charge of $49USD per 
incident for non-maintenance program users.

•	 E-mail: support@avenza.com 

•	 Web: www.avenza.com/support

•	 Online form: www.avenza.com/support/form

•	 User forum: www.avenza.com/forum

•	 Phone:  1 (416) 487-6442

Geographic Imager Maintenance Program (GMP)
Your Geographic Imager purchase includes a one-year membership in the Geographic Imager Maintenance Program. 
Enjoy worry-free use of Geographic Imager and all the benefits of the GMP. All GMP subscriptions begin on the date 
of purchase. Maintenance users can post questions under the Maintenance Users category of the Avenza user forum 
where Avenza support staff will be happy to post solutions and answers. The Geographic Imager Maintenance 
Program is guarantees its members:

•	 Unlimited priority technical support—guaranteed same business day (9-4 EST) or next business day response

•	 GMP only telephone support

•	 Free Geographic Imager updates

•	 Free Geographic Imager version upgrades

•	 Additional discounts and offers only available to GMP members
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For GMP subscribers, your e-mail address has been automatically entered in the gi-maintenance-l online e-mail list 
so that you are assured of receiving the latest GMP news and access to all the update and upgrade files. If you 
purchased your Geographic Imager license from a reseller or are the end user but not the person who purchased 
the software,  please contact us at sales@avenza.com to ensure that we receive your e-mail address and add you to 
the GMP notification group.

Maintenance Renewal
Approximately 6-8 weeks prior to the expiration of your annual GMP subscription you will be notified regarding 
renewal options. You will be contacted a minimum of five times prior to expiration in order to ensure that you 
have ample opportunity to renew or not at your discretion. You will have the option of renewing your GMP for an 
additional year at the then prevailing price or canceling without penalty. Of course, if you cancel or let your GMP 
lapse you will no longer be entitled to the benefits of the program as outlined above and will thus have to purchase 
future upgrades at the upgrade price.

There is a grace period of approximately 30 days from the time of the GMP expiry during which you may still renew 
without penalty. All post-expiration renewals will be backdated to the actual expiry date.

Lapsed Subscriptions
Failure to renew your GMP within 30 days from the expiry date will result in a lapsed GMP subscription. Lapsed 
subscriptions may not be renewed and the licensee will be required to purchase support and upgrades accordingly. 
Please direct all GMP questions and purchase inquiries to info@avenza.com.

Wishlist
As either a new or experienced Geographic Imager user we value your opinions on how we can improve our product. 
Please let us know what  functions you would like to see incorporated into future upgrades of Geographic Imager.

Post to our user forum with the subject "Feature Request" at www.avenza.com/forum
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